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Regulations/Compliance

In-Sight 1721/1722 Wafer Readers

Declaration of Conformity

Manufacturer Cognex Corporation

One Vision Drive
Natick, MA 01760 USA

Declares this C €-marked Wafer Reader Machine Vision System Product

Product Number In-Sight 1721: P/N 800-5865-1; P/N 800-5865-1R (RoHS Compliant)
In-Sight 1722: P/N 800-5865-2; P/N 800-5865-2R (RoHS Compliant)

Complies With 89/336/EEC Electromagnetic Compatibility Directive

Compliance Standards EN 61000-6-4:2001 Class A

EN 61000-3-2:2000 + A2:2005
EN 61000-3-3:1995 + A1:2001
EN 61000-6-2:2001

European Representative Cognex France
Immeuble le Patio

104 avenue Albert 1er
92563 Rueil Malmaison
France

Safety

(UL 508:Standard for Industrial Control Equipment)
CUL Certification marks are present on products

FCC Part 15, Class A

IEC 60825-1/A2:2001
EN 60825-1/A1:2002
Class 1 LED Product CAN/CSA-E60825-1:2003

Compliance

This equipment conforms with the applicable requirements of

SEMI SEMI S2-0703a
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In-Sight 1701 Wafer Reader

Declaration of Conformity

Manufacturer

Cognex Corporation
One Vision Drive
Natick, MA 01760 USA

Declares this c €-marked

Wafer Reader Machine Vision System Product

Product Number

In-Sight 1701: P/N 800-5797-1; P/N 800-5798-1

Complies With

89/336/EEC Electromagnetic Compatibility Directive

Compliance Standards

EN 55011:1998 + A1:1999 + A2:2002
EN 61000-3-2:2000 + A2:2005

EN 61000-3-3:1995 + A1:2001

EN 61000-6-2:2001

European Representative

Cognex France
Immeuble le Patio

104 avenue Albert 1er
92563 Rueil Malmaison
France

Safety

Information Technology Equipment (UL 1950) 51KJ
CUL Certification marks are present on products

FCC

FCC Part 15, Class A
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In-Sight® 1700 Series Wafer Reader

Declaration of Conformity

Manufacturer

Cognex Corporation
One Vision Drive
Natick, MA 01760 USA

Declares this c €-marked

Wafer Reader Machine Vision System Product

Product Number

In-Sight 1700: P/N 800-5748-10; P/N 800-5748-20

Complies With

89/336/EEC Electromagnetic Compatibility Directive

Compliance Standards

EN 55011:1998 + A1:1999 + A2:2002
EN 61000-3-2:2000 + A2:2005

EN 61000-3-3:1995 + A1:2001

EN 61000-6-1:2001

European Representative

Cognex France
Immeuble le Patio

104 avenue Albert 1er
92563 Rueil Malmaison
France

Safety

Information Technology Equipment (UL 1950) 51KJ
CUL Certification marks are present on products

FCC

FCC Part 15, Class A
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Precautions

Observe these precautions when installing the In-Sight wafer reader to reduce the risk of
injury or equipment damage:

®  The wafer reader is intended to be supplied by a Cognex power source (24V +10%).
Any other voltage creates a risk of fire or shock and can damage the In-Sight
hardware.

® Do not install the wafer reader in locations that directly expose it to environmental
hazards such as excessive heat, dust, moisture, humidity, impact, vibration, corrosive
substances, flammable substances, or static electricity.

®  To reduce the risk of damage or malfunction due to over-voltage, line noise,
electrostatic discharge (ESD), power surges, or other irregularities in the power
supply, route all cables and wires away from high-voltage power sources.

®  Although the wafer reader is a Class 1 LED Product, it is not recommended to stare
directly into the illumination LEDs when the wafer reader is receiving power. Note
that the In-Sight 1722 wafer reader LEDs emit infrared light, therefore the illumination
LED lights are not visible.

® Do not open the wafer reader. This device does not contain user-serviceable parts.
Do not make electrical or mechanical modifications to the In-Sight hardware. The
LED emitted light levels have not been tested when the wafer reader is open,
therefore Class 1 LED Product certification is not guaranteed if the wafer reader is
open. Unauthorized modifications violate your warranty.
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1 Introduction

In this section...

1.1 In-Sight Wafer Reader OVEIVIEW ...........coiiiiiiiiiiiiiee et 1
1.2 IN-Sight SUPPOIT... ..o e e e e e e e e e e e e e aanes 2
1.3 Networking an In-Sight Wafer Reader ... 2

1.1 In-Sight Wafer Reader Overview

The In-Sight® series of high performance vision sensors are image formation wafer
readers for reading identification marks on silicon wafers. Featuring a vision processor,
advanced lighting and optics, and built-in networking support and serial communications,
the compact In-Sight wafer readers can be utilized in virtually any back-end wafer fab
process.

The In-Sight wafer readers include the following models:

® In-Sight 1722: Infrared LED lighting, 1024 x 768 image resolution and variable
working distance

® In-Sight 1721: Red LED lighting, 1024 x 768 image resolution and variable
working distance

®  In-Sight 1701: Red LED lighting, 1024 x 768 image resolution, variable working
distance

®  In-Sight 1700: Red LED lighting, 640 x 480 image resolution, fixed working
distance

NOTE Toinstall the In-Sight 1721 or 1722 wafer reader using In-Sight Explorer, refer to Installing the
In-Sight® 1720 Series Wafer Reader hardware manual.

The In-Sight wafer reader is configured remotely over a network using a standard Internet
browser. This browser interface also allows remote monitoring of the wafer reader’s
operation during runtime. The wafer reader may also be controlled remotely from users’
custom application programs using In-Sight Native Mode commands to change settings
and retrieve read results.

Unless otherwise specified, references to the In-Sight 1721 wafer reader in this document
also apply to the In-Sight 1722, 1701 and 1700 models.
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1.2 In-Sight Support

The following resources are available to assist you in using the In-Sight wafer readers
and spreadsheet interface:
® In Sight® Guide & Reference, an on-line HTML Help file provided on the In-Sight
CD-ROM.

®  The In-Sight Online Support and Learning Center at:
www.cognex.com/support/In-Sight.asp.

1.3 Networking an In-Sight Wafer Reader

The In-Sight wafer reader is designed to operate as a host system on an Ethernet TCP/IP
network. For the purposes of the instructions in this manual, an In-Sight network exists
whenever one or more wafer readers can be accessed remotely from another host on the
network.

The wafer reader may be used in several possible network configurations. For each
configuration, the wafer reader is configured using an Internet browser, which also
provides the remote display for that wafer reader.

1.3.1 Standalone In-Sight Network Configurations

A standalone In-Sight network configuration includes a connection between an In-Sight
wafer reader and a PC equipped with a network card. The In-Sight 1721 wafer reader
has an Autosense capability, allowing the wafer reader to connect directly to a PC using
either a standard CAT5 network cable or a CAT5 crossover cable. In this configuration,
neither the PC nor the wafer reader is connected to the larger, fab floor network.
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Please note that the In-Sight 1700 and 1701 wafer readers require a standard CATS
network cable and crossover coupler or a CATS crossover cable in this configuration.

NOTE  If the Microsoft "Media Sense" feature, which automatically detects whether or not your network
interface is linked to a network, is enabled when running Microsoft Windows 2000 or XP,
communication with an In-Sight wafer reader may not be established. It is recommended to use a
hub or switch with a standard Ethernet cable to configure the In-Sight wafer reader or configure
your PC to disable the Media Sense feature. See Microsoft Knowledge Base article 239924 for
details on this process.

CAT5 Cable

In-Sight Wafer
Reader

Figure 1-1: Standalone In-Sight Network

Configurations Using Switches/Routers

An In-Sight network may be extended to include multiple In-Sight wafer readers by using
an Ethernet switch or network router. The only limit on the size of this type of network is
the number of routers or switches connected and the number of connections they
provide.

To install multiple wafer readers on a standalone In-Sight network, use a switch/router
between the wafer readers and the remote host. Make all connections via standard,
straight-pinned CAT5 cable (Figure 1-2).

Switch/Router

\__~ In-Sight Wafer N
In-Sight Wafer ~ Reader  In-Sight Wafer
Reader Reader

Figure 1-2: Standalone In-Sight Network With Ethernet Switch

COGNEX 3



Section 1: Introduction In-Sight® 1700 Series Wafer Reader

1.3.2 Fab Floor In-Sight Network Configurations

To take full advantage of its networking capabilities, the wafer reader can operate as a
host on the larger, fab floor network. The only physical difference between fab floor-
networked wafer readers and a standalone wafer reader network is that the switch/router
is connected directly to the network.

Groups of wafer readers connected to the fab floor network through a common
switch/router are referred to as a local network. Figure 1-3 shows a subnet that includes
several wafer readers and a PC.

Fab Floor Network

In-Sight Wafer
Reader

In-Sight Wafer
Reader

Figure 1-3: Fab Floor Network
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2 Installing the Wafer Reader

In this section...

2.1 Connecting the In-Sight Wafer Reader.............cccevviiiiiiiiiiiii e 6
2.2 Configuring the INternet BrOWSET ...........c..uviiiiiiei et a e 7
2.3 Installing the In-Sight Software ............coooiii e 10
2.4 Adding the Wafer Reader to the NetWork............ccccvviiiiieiiiiiiiiee e 11
2.5 Logging On to the In-Sight Wafer Reader ..o, 14
2.6 Communicating with the In-Sight Wafer Reader Over a Telnet Client.................... 17

2.1 Connecting the In-Sight Wafer Reader

This section describes the connection of the wafer reader to its standard components. To
connect the sensor to the optional 1350 Breakout Module, refer to Appendix C:
Connecting the Breakout Module. For a complete list of options and accessories, contact
your Cognex sales representative.

2.1.1 Connecting the In-Sight 1721/1722 Wafer Reader

The wafer reader has two RJ-45 connector ports: the Network Port and the Breakout Port
(see Figure 2-1). The Network Port provides the Ethernet connection for network
communications. The Breakout Port supplies connections for the 24VDC power source,
I/0O, acquisition trigger, and serial communications.

——= D S

RJ-45 Network RJ-45 Breakout
Port Port with Notch
(Keyed)

AN "/
CAT5 Cable Breakout Cable
(Keyed)

Figure 2-1: Location of RJ-45 Ports
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2.1.2 Connecting the In-Sight 1700/1701 Wafer Reader

The In-Sight 1700/1701 wafer reader has two RJ-45 connector ports: the Network Port
and the Breakout Port (see Figure 2-2). The Network Port provides the Ethernet
connection for network communications. The Breakout Port supplies connections for the
24VDC power source, |/O, acquisition trigger, and serial communications.

A\

Power LED

RJ-45 Breakout
Port with Notch
(Keyed)

RJ-45 Network
Port

Breakout Cable
(Black, Keyed)

CATS Cable
Figure 2-2: Location of RJ-45 Ports

2.1.3 Connecting the Network Cable

® [If you are connecting to an Ethernet switch, plug one of the RJ-45 connectors of a
CATS5 straight-pinned cable into the Network Port and plug the other end into an
available port on the switch/router.

® If you are connecting directly to an In-Sight sensor from a remote host, plug
one end of a CAT5 network cable into the wafer reader’s Network Port; plug the other
end into the remote host’s Ethernet port.

NOTE The In-Sight 1700 and 1701 wafer readers require a standard CAT5 network cable and crossover
coupler or a CAT5 crossover cable in this configuration.
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2.1.4 Connecting the Breakout Cable

The breakout cable provides access to the wafer reader’s power, serial communications,
and /O lines. The RJ-45 connector on this cable is “keyed” to the notch in the Breakout
Port, and cannot be inadvertently plugged in to the Network Port. See Section 8.2.1:
Breakout Port Pin Assignments on page 106 for the Breakout Cable’s wiring details.

To connect the sensor using the optional 1350 Breakout Module, refer to Appendix C:
Connecting the Breakout Module.

To Connect the Breakout Cable to the In-Sight Wafer Reader:
1 Verify the 24VDC power supply being used is switched off.

2 Attach the Breakout Cable’s power (white-green wire) and ground (brown wire) to the
corresponding terminals on the power supply.

3 Connect the wires for the acquisition trigger, discrete outputs, and serial
communications to their corresponding terminals on remote devices.

Plug the RJ-45 connector into the wafer reader’s Breakout Port (labeled 24VDC).

Restore power to the 24V supply. The green power LED will indicate that the wafer
reader is receiving power.

2.2 Configuring the Internet Browser

The In-Sight wafer reader is platform and operating system independent and can be
controlled using a standard, Java-enabled Internet browser. In most cases, a PC is
needed to set up a wafer ID application but is not necessary to monitor its runtime
operation.

When configuring the In-Sight browser interface to communicate with the wafer reader,
there are two main requirements:

®  The connection must be a local area network (LAN) connection (versus dial-up).

®  The connection must not be routed through a proxy server, virtual private network
(VPN), or similar gateway.

The In-Sight browser interface has been tested using Microsoft Internet Explorer versions
5.0.1 and later on Windows XP, 2000 and NT 4.0. Using a Windows XP/2000/NT PC
running Microsoft Internet Explorer 6 (or later) is strongly recommended. If using Internet
Explorer 6, the Java™ Virtual Machine is not installed as part of the typical installation,
but is installed on demand when a page using a Java Applet is first encountered. The
Sun Java virtual machine can also be used on a windows-based PC. For information
regarding installation, upgrade and setup of these software packages, see Tech Note:
Browser Setup and Java Installation for the In-Sight 1700 Series Applet, which is
available on the In-Sight 1700 Series CD, or can be downloaded from the

In-Sight Online Support & Learning Center at:

www.cognex.com/support/In-Sight.asp.

Whichever virtual machine is being used, it must be enabled for the In-Sight browser
interface to execute.
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To verify that a virtual machine is enabled:

1 Open Internet Explorer.
2 From the Tools menu select Internet Options....
3 Click the Advanced tab.

If using the Microsoft Virtual Machine, under the Microsoft VM settings, verify that JIT
compiler for virtual machine enabled is checked, as shown in Figure 2-3.

Internet Options E E I
Generall Securityl F'rivacyl Eontentl Eonnectinnsl Programs ~ Advanced
Settingz:
f_g Java [Sun) ;I
O UseJava 2 +1.41_01 for <applet> [requires restart]
@ bicrozaft Wi

[0 Java console enabled [requires restart]

O Java logging enabled

JIT compiler far virtual machine enabled [requires restart)
B8, Multimedia

[ Don't display online media cantent in the media bar
Enable Automatic Image Rezizing

Enable Image Toolbar [requires restart]

Flay animationz in web pages

Play sounds in web pages

Flay videos in web pages

O Show image download placeholders

Show pictures

Smart image dithering -
1 | 3
Bestore Defaults |

Cancel | Lpply |

Figure 2-3: Internet Options Dialog — Microsoft Virtual Machine Enabled

OR

If using the Sun Java Virtual Machine, under the Java (Sun) settings, verify that Use
Java... is checked, as shown in Figure 2-4.
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Internet Options K E3 I
Generall Securit_l,ll F'rivac_l,ll Eontentl Eonnectinnsl Programs  Advanced
Settingz:
f_é Java [Sun] ;I
UszeJava 2 w1.4.2_03 for <applet: [reguires restart)
5] Microsoft Wi

O Java console enabled [requires restart]

O Javalogging enabled

O NT compiler for vitual machine enabled [requires restart]
(8, Multimedia

O Don't display online media content in the media bar
Enable Automatic Image Resizing

Enable Image Toalbar [requires restart]

Flay animations in web pages

Flay goundsz in web pages

Play videos in web pages

O Show image download placeholders

Shaw pictures

Smart image dithering -
| 3
Restore Defaults |

Cancel | Sppl |

Figure 2-4: Internet Options Dialog — Java Virtual Machine Enabled

Also, if using the Sun Java Virtual Machine, verify that all browsers that will be running
the In-Sight applet are enabled for use with the Java Plug-in, as shown in Figure 2-5.
This can be verified from the Java Plug-in Control Panel. To open the Java Plug-in
Control Panel, select Start > Settings > Control Panel > Java Plug-in. From the Browser
tab, enable all applicable browsers.

4. Java{TM) Plug-in Control Panel oy ] 4|
rBasic rAdvanced rEruwser rPeries rCache rCeniﬂcates rUpdate rAbnut |

Setlings
Java(Thl) Plug-in will be used as the default Java Runtime in the following hrowser(s):
[¥] Microsaft Internet Explorer

[] Metscape & ar later

[] mMozilla 1.1 or later

| Apply H Reset || Help |

Figure 2-5: Browser Tab — Java Plug-in Control Panel

4 If a virtual machine was enabled, the browser must be restarted for the change to be
applied.
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2.3 Installing the In-Sight Software

A Microsoft® Windows®-based PC is required to run the In-Sight PC Host program and to
add the wafer reader to the network. The following must be installed on the PC to load
In-Sight PC Host Software:

A Microsoft Windows XP, 2000 or NT 4.0 (with Service Pack 4 or later) operating
system.

Network Interface Card (at least 100Mbps) for connecting to In-Sight wafer readers
In-Sight software (included on the CD-ROM shipped with your wafer reader).
Internet Explorer 5.01 or higher to display the In Sight® Guide & Reference.

Perform the Following Steps to Install the In-Sight Software:

1
2

4

Shut down any applications on your PC.

Insert the In-Sight CD-ROM into your PC’s CD-ROM drive. If Autoplay is enabled, the
software should automatically launch the ISSetup.exe program.

Select the appropriate installation option; follow the setup dialogs as they appear on
screen.

When the installation program is complete, remove the CD from the CD-ROM drive.

If the Install Program Does Not Start Automatically:

1
2

5

Click the Start menu, click Run, then click Browse.

In the browse window, select the PC’s CD-ROM drive, then select the ISSetup.exe
file.

Click Open, then click OK to begin the installation.

Select the appropriate installation option; follow the setup dialogs as they appear on
screen.

When the installation program is complete, remove the CD from the CD-ROM drive.

Verify the In-Sight Software Installation:

1

Verify the In-Sight software installation by opening the Start menu and clicking All
Programs > Cognex > In-Sight > In-Sight Wafer ID (Java) 3.x.x > In-Sight PC Host.

Verify the In Sight® Guide & Reference help file installation by opening the Start
menu and clicking All Programs > Cognex > In-Sight > In-Sight Wafer ID (Java) 3.x.x
> In-Sight Help.

NOTE From the Wafer ID (Java) 3.x.x program group, select the Release Notes for current information

about In-Sight software, including new features, fixes and known issues. Registered In-Sight users
can download updated versions of In-Sight documentation at:
http://www.cognex.com/support/In-Sight.asp.

COGNEX


http://www.cognex.com/support/In-Sight.asp

In-Sight® 1700 Series Wafer Reader Section 2: Installing the Wafer Reader

2.4 Adding the Wafer Reader to the Network

After the power and network connections to the wafer reader have been made and the
In-Sight PC Host program has been installed to a networked PC, the wafer reader can be
added as a host on the network.

NOTE If the Microsoft "Media Sense" feature, which automatically detects whether or not your network
interface is linked to a network, is enabled when running Microsoft Windows 2000 or XP,
communication with an In-Sight wafer reader may not be established. It is recommended to use a
hub or switch with a standard Ethernet cable to configure the In-Sight wafer reader or configure
your PC to disable the Media Sense feature. See Microsoft Knowledge Base article 239924 for
details on this process.

As previously described, there are many possible In-Sight network configurations. The
specific procedure for adding wafer readers to a network depends on whether or not a

Dynamic Host Configuration Protocol (DHCP) server is available. The DHCP server
automatically assigns the wafer reader a network IP address and Subnet Mask.

NOTE When installing the wafer reader to an existing network, consult your network administrator to
determine whether a DHCP server is available.

2.4.1 Installing to a DHCP Network

The wafer reader is factory-configured for installation on an existing network with a DHCP
server. After connecting the CATS network cable and the Breakout cable, the DHCP
server will automatically detect the wafer reader, configure its settings, and install it on
the network.

After adding a wafer reader to a network using DHCP, it is recommended that DHCP is
disabled on the wafer reader and a static IP address is assigned.

NOTE  You will need to record the IP address to connect to the wafer reader from an Internet browser. To
find the IP address that is assigned to the wafer reader, run the In-Sight PC Host program, then
open the System menu and select Settings » . From the Settings menu, select Network.
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2.4.2 Installing to a Non-DHCP Network

A static IP address must be assigned to the wafer reader before the wafer reader will be
recognized on a network where a DHCP server is not available.

To Install the In-Sight Wafer Reader on a Non-DHCP Network:
1 Supply power to a wafer reader, then open the In-Sight PC Host program.

2 From the In-Sight spreadsheet, press <ESC> to open the System menu.

System

Oriline
Live
Logan
Mewy Job
Sawve & Load
Settings ¥
Prafiler
Custamize
“ersion

Close

Figure 2-6: PC Host System Menu

3 Select Logon to open the Logon dialog.

Logan

Hast Mame
Lser Mame
Passward |:|
Pratocaol

(e R [ o |

Figure 2-7: PC Host Logon Dialog

4 Click on the Host Name drop-down list to see the names of any In-Sight sensors
already installed on the network.
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5 Select < New > from the list to open the New Host Configuration dialog.

Mew Host Configuration

MAC Address
IP Adiress 0]
Subnet Mask El El

Figure 2-8: PC Host New Host Configuration Dialog

6 Enter the last six characters of the wafer reader’s 12-character Media Access
Control (MAC) address, without spaces or dashes. The first six characters are
already entered, and should not be deleted or changed.

NOTE The MAC address is located on the serial number label affixed to the wafer reader. This identifier is
factory-assigned, unique for every In-Sight wafer reader, and cannot be changed or deleted.

7 Verify that the Use DHCP checkbox is disabled.

8 Enter a valid IP Address for this wafer reader. Every wafer reader must be assigned
a unique IP address consistent with the addressing scheme in use on the network.
Refer to Appendix B for more information on assigning an IP address, or consult your
network administrator.

9 Enter a Subnet Mask for the local network. The Subnet Mask specifies which parts
of the wafer reader’s IP address are the same for all hosts on the local network, and
which are unique to each host. Refer to Section 6.3, or consult your network
administrator for more information.

10 Click OK. The message box shown below appears.

Message

Make sure the host to be configured is switched off and connected
to the network. Then switch it on to continue with the IP configuration.

Listening £

Figure 2-9: IP Configuration Message Box
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11 Cycle power on the wafer reader by removing, then reinserting, the RJ-45 connector
from the wafer reader's Breakout Port. When the wafer reader has been located on
the network, the following message appears:

MMessage

IP configuration complefed successfuly!

Figure 2-10: IP Configuration Completion Message Box

If this message does not appear within one minute of cycling power, click Abort. The
New Host Configuration dialog will reappear. Verify that the IP address entered is valid
and the Subnet Mask is appropriate for the local network. Make corrections as
necessary, and repeat steps 1 through 11. Contact your network administrator if
problems persist.

NOTE The wafer reader's network settings can also be modified (i.e., disable DHCP and assign a static
IP) with HyperTerminal through the serial port using the SetNetwork extended Native Mode
command. For more information on the command, refer to the In Sight® Guide & Reference HTML
Help file.

This completes the basic installation procedure of an In-Sight wafer reader onto a
network. Additional, optional network settings may be configured as described in Section
6.3.

2.5 Logging On to the In-Sight Wafer Reader

As described in the Introduction, a standard Internet browser is used to configure and
monitor wafer ID applications on the wafer reader. When a connection to a wafer reader
is made from a browser, the Java applet resident in the wafer reader flash memory
automatically loads in the browser window.

NOTE Java virtual machine (JVM) software must be installed on the host platform and supported by the
browser used to connect to the wafer reader. Many browsers automatically install Java support, but
this option may not have been enabled when your browser was installed. For information regarding
installation, upgrade and setup of JVM software packages, see Tech Note: Browser Setup and
Java Installation for the In-Sight 1700 Series Applet, which is available on the In-Sight 1700 Series
CD, or can be downloaded from the In-Sight Online Support & Learning Center at:
www.cognex.com/support/In-Sight.asp.
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To Open a Connection to an In-Sight Wafer Reader from an Internet Browser:

1 Enter the IP address of the wafer reader into the browser’s Address Bar (for example,
http://192.168.0.1). The HTTP Logon dialog (labeled Enter Network Password dialog
when using Internet Explorer), opens.

Enter Network Password EE

% Pleaze type pour uzer name and password,
Siter 192168.01

Realm In-Sight

User Mame Iadmin

Pazzword I

¥ Save this password in vour password list

Cancel |

Figure 2-11: Enter Network Password Dialog

NOTE The IP address shown in Figure 2-11 is only an example. Every wafer reader installed on the same
subnet must have a unique IP address, which must be consistent with the addressing scheme in
use on that network.

2 Inthe HTTP Logon dialog, enter the default User Name admin.

Every wafer reader is pre-configured with three User Names: admin, operator, and
monitor. Each User Name is assigned a specific Access level. The Access level
controls how much interaction is allowed for the current user to prevent inadvertent or
unauthorized changes to the configuration.

®  Admin Level (Full): The user has complete, unrestricted access to the In-Sight
wafer reader. Any job may be loaded, changed, and saved, and all menu
selections are available.

®  Operator Level (Protected): The user has limited access to the wafer reader,
which runs only in the Custom View mode of the spreadsheet. A user in
Protected mode can edit the values of all Graphics Controls functions visible in
the Custom View, but cannot change the functions themselves. The System
menu is available to toggle the wafer reader Online/Offline, access Live mode,
Save & Load jobs (if permitted by their FTP Read/Write privileges), and
Customize the appearance of the interface.

®  Monitor Level (Locked): The most restrictive level of access available, a user in
Locked mode can only monitor the operation of the current wafer reader in
Custom View. The System menu is disabled.

NOTE If you are connecting to a newly installed wafer reader, leave the Password field blank. If you
are connecting to a previously installed wafer reader, you may need to enter a password.
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3 Click OK to logon to the wafer reader. The In-Sight Home Page will begin loading
automatically in the browser. Wait for the page to finish loading before making any
further selections.

NOTE If there is no job loaded in the spreadsheet or the job is incompatible with the Java applet, an
Invalid Job dialog appears. Click the OK button and open a compatible job. For more
information on opening a job, see Section 4.3.

: Inwalid Job [_ O] =]

Pleaze load a compatible job.

|Warning: Applet Window

Figure 2-12: Invalid Job Dialog

To Suppress the HTTP Logon Dialog When Connecting to a Wafer Reader:

The user name and password can be specified as part of the address, allowing you to
suppress the HTTP Logon dialog. The address must be typed using the following format
into the browser's Address Box:

http://hostname/filename?isSL=username+password

NOTES

m  “?isSL=username+password" is case sensitive; no spaces are allowed. If there is no password, leave
it blank, without spaces. The “+” must be included, even if no password is entered.

m Ifnofilename is specified, Index.htm will be opened in the browser.
m  ‘hostname” can be either the Host Name or the IP address of the wafer reader.

m  During a single HTTP session, do not connect to a wafer reader using both the HTTP Logon dialog
and without.

Examples:
To log on to the wafer reader as operator, with no password and open the index.html file:

http://is1721 _00060b/?isSL=operator+

To log on as admin, with the password Cognex and open the System Settings menu:

http://192.168.0.1/system.htm|?isSL=admin+Cognex

16 COGNEX


http://hostname/filename?isSL=username+password
http://is1721_00060b/?isSL=operator+
http://192.168.0.1/system.html?isSL=admin+Cognex

In-Sight® 1700 Series Wafer Reader Section 2: Installing the Wafer Reader

2.6 Communicating with the In-Sight Wafer Reader
Over a Telnet Client

Telnet is a built-in Microsoft Windows client that can be used to remotely communicate
with the wafer reader using In-Sight Native Mode commands.

NOTE By default, the Telnet system idle timeout is 5 minutes.

2.6.1 Logging On to the In-Sight Wafer Reader Using Telnet

The wafer reader allows for three active Telnet sessions. If a user attempts to log on to a
wafer reader (with the same User Name as one of the sessions already open) and all
three sessions are in use, the oldest session with the same User Name is closed and the
new session is opened.

There are three possible session numbers. Each session number signifies the number of
active Telnet and browser interface connections. There can only be one active browser
interface connection at a time.

Session 0: There are no other active connections.

Session 1: There is one other active connection.

Session 2: There are two other active connections.

For example, there are three active connections: Session 0, Session 1 and Session 2.
Session 0 and Session 2 are closed. The next connection will be Session 1 (since there
is one other active connection).

1 Open the Telnet client application on the remote host.

e C:AWINDOWS\system32vcmd. exe

Microzsoft Windows HP [Uersion 5.1.26801
CC» Copyright 1985-28001 Microsoft Corp.

| R

Figure 2-13
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2 In the Telnet application, connect to the wafer reader by either its Host Name or IP
address (for example: is1721_00060b or 192.168.0.1). If the connection is
successful, a "Welcome to In-Sight(tm)" message appears, along with the hardware

type (for example: 1722, 1721, 1701 or 1700), the session number and a prompt for
“User:”.

AWINDOWS\system32vemd. exe

Microzoft Windows AP [Version 5.1.26801
CC» Copyright 1985-28001 Microsoft Corp.

P:~>telnet i=1721_BAHAB6AL

Figure 2-14

3 Enter avalid User name and Password for the In-Sight wafer reader. The User name
and Password entered must exist in the User List for that wafer reader. If the log on is
successful, the message "User Logged In" will appear.

& Telnet is1721_00060b _|o J

Welcome to In—Sight<tm> 1721 Session B
Uzer: admin

Paszsword:

Uzer Logged In

Figure 2-15

NOTE When logging on to a wafer reader through Telnet from a Unix-based platform, the wafer reader’s
Host Name (or IP address) and port number (usually 23) must be added to the command line. For
example: >telnet is1721_00060b 23. Supplying the port number disables the Unix

username/password authentication and forces the Unix system to prompt you for user name and
password.
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3.1 SEMI® Wafer Marking Specifications

The In-Sight wafer reader identifies wafers marked according to the following
specifications:

m  SEMI T7-0997 — Specification For Back Surface Marking of Double-Side
Polished Wafers With A Two-Dimensional Matrix Code. Defines the
characteristics and positioning of the rectangular 2D Data Matrix code symbol
marked on the back surface of 300mm wafers.

= SEMI M12-0998 — Specification For Serial Alphanumeric Marking of the Front
Surface Of Wafers. Defines the characteristics and positioning of the 12-character
alphanumeric string marked on the front surface of 100/125/150mm (flatted) and
150/200mm (notched) wafers.

= SEMI M1.15-1000 — Standard For 300mm Polished Monocrystalline Silicon
Wafers (Notched). Combines elements of the SEMI T7 and SEMI M12 specifications
for defining the characteristics and positioning of the rectangular 2D Data Matrix code
symbol and the (optional) 12-character alphanumeric string marked on the back
surface of 300mm wafers.

= SEMI M13-0998 — Specification For Alphanumeric Marking Of Silicon Wafers.
Defines the characteristics and positioning of the 18-character alphanumeric string
marked on 100/125/150mm (flatted) and 150/200mm (notched) wafers.

= SEMI T1-95 - Specification For Back Surface Bar Code Marking Of Silicon
Wafers. Defines the characteristics and positioning of the barcode marked on the
back surface of 125mm or larger wafers.

For copies of the complete specifications, visit the Semiconductor Equipment and
Materials International (SEMI) organization at:

WWW.Semi.org.
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3.2 Basic Concepts

Wafer reading recipes created using In-Sight are called jobs. Each job can contain up to
10 unique reading configurations, called Configs. Each Config specifies a type of wafer
mark, a checksum, the string fielding, light settings, and other information. An automatic
tuning operation can be used to optimize Config settings for maximum reading reliability.

Jobs can run multiple Configs in a retry sequence until a successful read is achieved, or
the mark cannot be read within the time permitted. Optionally, Configs can be tuned
automatically during runtime if the retry sequence fails to report a successful read.

When a Config is tried, it reports a string of characters for successful reads, or a string of
asterisks (***) or partially read characters and question marks for failed reads. In either
case, a read score is reported.

All of the steps necessary to configure a standard wafer ID application are performed in
the user interface that loads automatically when you connect to a networked wafer reader
using a Java-enabled web browser, as described below.

3.3 GUI Overview

The user interface that loads in the web browser when connecting to a wafer reader is
divided into five main areas:

= The File tab is used to open, save and delete job (.JOB) files. The File tab also
provides quick File Transfer Protocol (FTP) access to files in the wafer reader’s flash
memory.

= The Setup tab is used to select Config settings, which can then be optimized through
the automated tuning process.

= The Options tab is used to specify various runtime settings that determine how the
job will execute. These settings include the source of the image acquisition/read
trigger, the retry method to use for enabled Configs, and the data format and output
destination of read results. The Options tab also provides a hyperlink to the System
Settings page (see Section 6: System Settings).

= The Run tab is the runtime view of the wafer reader’s operation, showing the most
recent read results and statistics for the Configs enabled in the job. The Run tab is
the default view whenever a wafer reader is accessed through a web browser, and is
the only view allowed when a wafer reader is Online.

m  Status bar. The status bar shows (from left to right) the Host (Host Name or IP
Address) for the connected wafer reader, the Access level for the current user (Full,
Protected or Locked), the name of the Current User, and the name of the user that is
logged on with Admin/Operator privileges.

NOTE  Only one Admin/Operator user at a time may log on to the browser interface.

COGNEX



In-Sight® 1700 Series Wafer Reader Section 3: Configuring a Wafer ID Application

3.4 Getting an Image

Before Config settings can be defined for reading wafer marks, a reasonable image of the
mark is needed.

NOTE  For specific information on setting the working distance and adjusting the focus of an In-Sight 1721
or 1722 wafer reader, see Appendix D: 1721/1722 Wafer Reader Installation Options. For specific
information on setting the working distance and adjusting the focus of an In-Sight 1701 wafer
reader, see Appendix E: 1701 Wafer Reader Installation Options.

1 Inthe Run tab, disable the Online checkbox.
2 Click the Setup tab.

3 Click the Live button. Position the wafer mark horizontally in the field of view (FOV),
making sure that the entire mark is visible in the image.

File |Setup  [Options [Run

Collapselmane | Aeguire |

Zoom |1DD% 'I

. ‘
_
Eead | String' Score |

Host: 192.168.0.1 Access: Ful Current User: admin Admin/Operator: admin

Figure 3-1: Position Mark Using Live Mode
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4 When the mark is properly positioned in the image, double-click the image or click the
Manual button to exit Live mode.

= [f the image is too bright or too dark, adjust the Light Mode and Light Power
slider controls until the mark can be seen against the wafer background.

m If the mark is inverted or mirrored in the image, select a different
Image Orientation from the drop-down list.

File |Setup  [Options [Run |

Expand Image |

L | Zoom |1DD% 'l

Config 0 |[Config]  [Config2  |[Configd  |Configd  |Configs  [Configf | Config?  |Torfigd  |[Corfigd |
v Enabled Accept |50 Character Threshald |25 Color |&uwto =] Rety |Disable =
Mark. |Chars, SEMI =1 Image Drientation INDrmaI - I Adyanced |
Checksum | SEMI with ‘irtual | Light Mode [BF1] 4 » Edit Region |
Field String I ”””””””””” (] Light Power [2] | | I 4 | E dit Size: |
Field Def I Character 5pacing @ Standard € Relaxed Tune |
Read | String | Score I
Host: 192.168.0.1 Access: Ful Current User: admin Admin/Operator: admin

Figure 3-2: Adjusted Mark

Repeat steps 1 through 4 as necessary.

NOTE  The lighting does not need to be optimized at this stage; the wafer mark need only be visible in the
image. Light optimization occurs during tuning.

When the mark is suitably imaged in the FOV, the first Config can be defined, as detailed
in the following sections.
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3.5 Defining Config Settings

The Setup view contains individual tabs for each Config, numbered 0-9 (see Figure 3-3).
Each Config contains the same default settings. These settings can be customized
according to the type and quality of wafer marks that will be read.

NOTE  Settings can be copied between Configs. To copy settings from one Config to another, click and
hold the left mouse button on the source Config tab then drag-and-drop on the tab of the target
Config; select OK in the Copy Config dialog. When Configs are copied, the stats from the source
Config are also copied to the target Config.

File |Setup  [Options [Run |

Expand Image | Live | Zoom |1DD% vl

Config 0 |Configl  [Config2  [Configd  |Configd  |Corfigs  [Configh | Config? | Corfigd  [Corfigd |
[V Enabled Accept |50 Character Threshald |25 Calor |éuwo =] Rety |Disable =l
Mark. | Chars, SEMI =1 Image Drientation I Normal - l Adyanced |
Checksum | SEMI with ‘irtual =1 Light Mode [EF1] ] ] EditFegion |
Figld String | ““““““““““ [ Light Power [2] 1 | I 4 | E dit Size |
Field Def | Character Spacing @ Standard ¢ Felaxed Tune |
Fead | Stringl Scare I
Host: 192.168.0.1 Access: Ful Current User: admin Admin/Operator: admin

Figure 3-3: Config Settings

The following sections describe each of the settings and available selections in detail.

3.5.1 Expand Image

The Expand Image button allows you to increase the size of the image area. The Config
settings are hidden while in Expanded mode. This mode is especially useful when
properly positioning a mark in the image area.

3.5.2 Zoom

The Zoom drop-down list allows you to increase the magnification of the image area
(63% to 1600% for the 1722, 1721 and 1701 wafer readers; 100% to 1600% for the 1700
wafer reader). This is especially useful when a high degree of precision is required in
positioning graphics.
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3.5.3 Enabled

The Enabled checkbox determines whether the Config will be used during the retry
sequence at runtime. The retry order for Configs is specified in the Options tab (see
Section 3.6). When Enabled is checked, the Config number on the tab appears in bold
text.

NOTE  All Config settings are saved with the job, even when the Config is disabled.

3.5.4 Mark

The Mark setting specifies the type of wafer mark the selected Config will read.

SELECTION DESCRIPTION
2D Sym, T7 Data Matrix Reads a SEMI T7 standard 2D Data Matrix symbol (ECC 200, 8 rows by 32 columns).
BC, BC 412 Reads a SEMI T1-95 standard barcode. (See Advanced section, below.)
BC, IBM 412 Reads an IBM 412 barcode. (See Advanced section, below.)
Chars, SEMI (default) Reads SEMI M12, M13, and M1.15 standard alphanumeric character strings. (See Advanced
section, below.)
Chars, IBM Reads IBM Hexadecimal alphanumeric character strings.
Chars, Triple Reads Triple Density standard alphanumeric character strings.
Advanced

Chars, SEMI Advanced Dialog

When ‘Chars, SEMI’ is the selected Mark, the Advanced dialog can be accessed from the
Advanced button (see Figure 3-4).

RE

O ptirnization I Speed ;I

.......................................

0K e

|'-.-'u'arnin-;|: Applet Window

Figure 3-4: Chars, SEMI Advanced Dialog

The Optimization drop-down list specifies reading performance options for standard
alphanumeric character strings. There are two Optimization options: Speed and
Reliability. Speed reads the Mark faster, but may be less accurate. Reliability minimizes
misreads by reading the Mark at a slower rate.
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NOTES

m  Speed is the default Optimization setting that is used for compatibility with all previous versions of
the In-Sight wafer reader.

m The read score may vary depending on the Optimization setting; verify that the Accept and Char
Threshold settings correspond to the selected Optimization setting.

BC, Compress Advanced Dialog

When ‘BC, BC 412’ or ‘BC, IBM 412’ is the selected Mark, the Advanced dialog can be
accessed from the Advanced button (see Figure 3-5).

RETS

Compreszion I Maone ;I
Feport " Hyphen [T Three Digt
I:IK | ........... I: anl:el .......... .\,

Warming: Applet Window

Figure 3-5: BC, Compress Advanced Dialog

The Compression drop-down list specifies options for decoding compressed barcodes,
including Base 35 compression, as well as a selection for decoding a barcode with no
compression.

When one of the Compressed options (Compressed 1 to Compressed 8) is selected,
Report settings are also available. If Hyphen is enabled, the last two digits of the
barcode string are separated by a hyphen. If Three Digit is enabled, the digits that are
encoded for the wafer lot number are replaced by a three-digit number; zeros (0) are
used as place-holders if the lot number is less than three digits. For example, if the
encoded lot number is “12”, the lot number would be reported as “012”. Report settings
are ignored if ‘None’ is the selected Compression.

NOTE For specific information on the customized decoding options, please contact your Cognex Sales
Engineer.

3.5.5 Checksum

The Checksum setting selects the method by which the read result from a character
string will be validated to ensure reliability, and establishes the scoring basis for
determining the pass/fail status of the read.

NOTE The Checksum setting is enabled and used only when ‘Chars, SEMI’, or ‘Chars, Triple’ is the
selected Mark. When any other Mark is selected, the Checksum setting is ignored.
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In all cases, the raw read score of the character string must be higher than the specified

Accept threshold before the checksum will be evaluated (see Section 3.5.7). Then if the

character string passes its checksum, bonus points in increments of 100 and/or 200 are

added to the raw reading score and the read passes. The number of bonus points added
to the raw score depends on the Checksum selected.

When Virtual checksum is selected by itself, the Accept threshold should be increased,
and the Field String & Field Definition should be made as specific as possible to limit the
list of possible characters at each position in the string. These steps will increase reading
reliability in the absence of a mathematical checksum.

SELECTION

DESCRIPTION

Virtual

The Cognex Virtual checksum attempts to validate the read result using multiple reading methods.
If all methods read identical characters at each position in the string, the string passes the Virtual
checksum and 100 points are added to the raw response score.

This checksum should be used by itself only when the character string is known not to contain one
of the other checksums, and then a higher Accept threshold is strongly recommended.

Maximum score: 200 points
Minimum passed score: 100 plus Accept threshold

SEMI

Applies the SEMI-standard checksum and the Cognex Virtual checksum. If the read result passes
the SEMI checksum, 200 points are added to the raw score. If the read result also passes the
Virtual checksum and the results from both checksums agree, an additional 100 points are added
to the score.

The read must pass the SEMI checksum to be successful; if Virtual checksum passes but the
SEMI checksum fails, the entire read will fail.

Maximum score: 400 points
Minimum passed score: 200 plus Accept threshold

SEMI with Virtual

Applies the SEMI-standard checksum and the Cognex Virtual checksum. If the read result passes

(default) the SEMI checksum, 200 points are added to the raw score. If the read result also passes the
Virtual checksum and the results from both checksums agree, an additional 100 points are added
to the score.

The read must pass both the SEMI and Virtual checksums to be successful; if either checksum
fails, the entire read will fail.

The SEMI with Virtual checksum selection is the most reliable method of validating a character
string containing a SEMI checksum.

Maximum score: 400 points

Minimum passed score: 300 plus Accept threshold

BC 412 with Virtual Applies the SEMI-standard barcode checksum and the Cognex Virtual checksum. If the read result
passes the BC 412 checksum, 200 points are added to the raw score. If the read result also
passes the Virtual checksum and the results from both checksums agree, an additional 100 points
are added to the score.
The read must pass both the SEMI BC 412 and Virtual checksums to be successful; if either
checksum fails, the entire read will fail.
This selection is typically used when the character string is marked directly below the barcode on
the wafer.
Maximum score: 400 points
Minimum passed score: 300 plus Accept threshold

IBM 412 with Virtual Applies the IBM barcode checksum and the Cognex Virtual checksum. If the read result passes

the IBM 412 checksum, 200 points are added to the Raw Score. If the read result also passes the
Virtual checksum and the results from both checksums agree, an additional 100 points are added
to the score.

The read must pass both the IBM 412 and Virtual checksums to be successful; if either checksum
fails, the entire read will fail.

This selection is typically only used when the character string is marked directly below the barcode
on the wafer.

Maximum score: 400 points
Minimum passed score: 300 plus Accept threshold

26

COGNEX




In-Sight® 1700 Series Wafer Reader

Section 3: Configuring a Wafer ID Application

3.5.6 Field String and Field Definition

The Field String and Field Definition settings work together to define the format of the
character string when ‘Chars, SEMI’, ‘Chars, IBM’, ‘Chars, Triple’, or one of the barcodes
is the selected Mark type.

NOTES
m Both The Field String and Field Definition settings are case sensitive.
m  When ‘Chars, IBM' is the selected Mark, the only valid characters are Hexadecimal.

m  When 2D Sym, T7 Data Matrix’ is the selected Mark, the Field String and Field Definition settings
are ignored.

Field String

The Field String specifies the characters, and number of characters, contained in the
character string or encoded in a barcode, including alphanumerics (A-Z, 0-9), dashes (-),
dots (.), and spaces.

Each character in the Field String corresponds to an indexed field position between 0 and
21. The Field String must contain the same number of positions as there are characters
in the wafer mark for the read to pass.

NOTE  For compressed barcodes, the field string is the actual number of encoded characters, not the
number of characters that are expected to be returned. For example, a compressed barcode may
contain 7 encoded characters, but return 11 characters when the barcode is read. Therefore, 7

characters would be entered in the field string.

By default, each position in the Field String is represented as an asterisk (*) character, or
alphanumeric “wildcard.” This means that any character A-Z or 0-9 is valid at any position
in the string. However, an individual position in the Field String can be limited to consider
only a subset of possible characters at that position. This increases overall performance
and reliability because characters that are not possible at a position will not be
considered during a read. The following table lists predefined “field definitions” that can
be entered in the Field String:

FIELD STRING DEFINITION VALID CHARACTERS
ENTRY
* Alphanumeric wildcard ABCDEFGHIJKLMNOPQRSTUVWXYZ
0123456789
Alpha ABCDEFGHIJKLMNOPQRSTUVWXYZ
Numeric 0123456789
Hexadecimal 0123456789
ABCDEF
D Decimal 0123456789
()
C SEMI Checksum, alpha ABCDEFGH
S SEMI Checksum, numeric 01234567
X Alphanumeric wildcard, alpha, numeric, ABCDEFGHIJKLMNOPQRSTUVWXYZ
hexadecimal, decimal, SEMI Checksum, dot and 0123456789
dash ()
()

COGNEX
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FIELD STRING DEFINITION VALID CHARACTERS
ENTRY

() dot ()

) dash ()

space space space

NOTE Al characters that are not predefined or entered in the Field Definition are treated as an
alphanumeric wildcard.

Example: The Field String entry for a SEMI M12 standard character string can be
FrweerxCS (the default Field String settin%). Any alphanumeric character is valid in the
first 10 Field String positions. But in the 117 position, only alpha characters A-H will be
considered during the read. And in the 12™ position, only numeric characters 0-7 will be
considered.

Fielding Barcodes

When the selected Mark is a barcode, the Field String must be changed so that it is
appropriate for the selected barcode mark.

To determine the barcode field string length and mark type, count the number of strokes
in the barcode. Divide the number of strokes by 4 to determine the number of characters
in the string. The remainder can be used to determine the barcode mark type.

REMAINDER BARCODE MARK TYPE

0 Invalid mark type
1 ‘BC, IBM 412’
2 Invalid mark type
3 ‘BC,BC 412’

Example:
1 The barcode contains 29 strokes.
2 29 divided by 4 equals 7. Therefore, there are 7 characters in the string.

3 After dividing by 7, the remainder is 1. Therefore, the mark type is IBM 412.
Field Definition

Optionally, the Field Definition setting can be used to create user-defined entries for the
Field String if Mark specifies a character string or barcode. When included in the Field
String, these entries restrict the list of valid characters at the positions in which they are
inserted.

= Multiple field definitions can be used, separated by a semicolon (;).

m  Characters listed for a Field Definition entry must be contained in the font or barcode.
For example: &=123 is valid, because 1, 2, and 3 are valid characters. However,
123=& is invalid because ‘&’ is not included in the standard Semifont or barcode
character sets.
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NOTE  Using one of the predefined entries (*, A, N, H, D, C, S, X, dot, dash, space) in the Field Definition
will remap the list of valid characters to the new definition. Therefore, it is strongly recommended
that you do not use a predefined field definition.

Example: If the Field Definition is &=123;$=3456;%=789, and the Field String is
&$%*******CS, then the only characters that will be valid in the first position will be 1, 2, or
3. The only valid characters in the second position will be 3, 4, 5, or 6. And in the third
position, only 7, 8, or 9 will be valid.

3.5.7 Accept

The Accept value specifies the minimum response threshold for the raw reading score
(40 to 100; default = 50). The meaning of the Accept value and its role in determining the
pass/fail status of a read depends on the type of wafer mark.

In all cases, before a read can be considered successful, the raw score must exceed the
Accept threshold. Only then will the bonus points for passing the checksum be added to
the raw score, and the pass/fail status of the read determined.

m  Characters. The response score for a character string is derived from the average of
the individual scores for all characters in the string. Refer to Section 3.5.5 for a
detailed explanation of how the raw score combines with a checksum to determine
the total score and pass/fail status of the read.

NOTE Itis possible for the raw score to exceed the Accept value even when individual character
scores fall below the specified threshold, as long as each individual character scores above
the Character Threshold. This allows character strings where all but one or two characters
score above the threshold to be read successfully.

= 2D symbol. The response score for a 2D symbol is the score for locating the mark in
the image. If the 2D mark cannot be located, the score will be 0 and the read fails. If
the 2D mark is located and the mark is decoded, 300 bonus points are added to the
raw score (passed scoring range: 340 — 400).

NOTE  Acceptis ignored when ‘2D Sym, T7 Data Matrix’ is the selected Mark type.

= Barcode. The response score for a barcode is the percentage of “scan lines” within
the Region that correctly detect the length of the string encoded in the barcode. If at
least three scan lines decode the same string that passes the checksum, 300 bonus
points are added to the raw score (passed scoring range: 310 — 400).

NOTE  Accept is ignored when a barcode is the selected Mark type.

3.5.8 Character Threshold

When ‘Chars, SEMI’, ‘Chars, IBM’ or ‘Chars, Triple’ is the selected Mark, the Character
Threshold value specifies the minimum response threshold for each individual character
score (25 to 100; default = 25). Each individual character score must be greater than the
Character Threshold or the read will fail.
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3.5.9 Image Orientation

The Image Orientation setting selects the orientation of the wafer mark in the image. The
default orientation is Normal.

SELECTION

DESCRIPTION

Normal (default)

Unmodified image acquired by the wafer reader.

Mirrored horizontally

Horizontally mirrors the acquired image.

Flipped vertically

Vertically flips the acquired image.

Rotated 180 degrees

Rotates the acquired image by 180 degrees.

3.5.10 Light Mode and Light Power

Each Config can have unique Light Mode and Light Power settings for optimizing the
readability of the wafer mark in the image. In-Sight will automatically determine the
optimal light settings for a mark during the tuning process if the Light checkbox in the

Tune dialog is enabled.
Light Mode

The Light Mode setting specifies either a Bright Field or a Dark Field illumination effect on
the mark. Each position on the Light Mode slider control enables specific groups of LEDs
to achieve the intended effect in the image.

SELECTION

DESCRIPTION

Slider position 0

All'lights are disabled. Use this mode only when an external light source is required in a
specialized application.

Slider positions 1-3

The mark will appear dark on a light background.

(BF1-BF3) Default = BF1
Slider positions 4-12 The mark will appear light on a dark background.
(DF1-DF8)

Light Power

The Light Power setting controls the effective intensity of the LEDs on the mark by
increasing the exposure time of the wafer reader’'s CCD imager, in increments of 0.167
milliseconds. Decrease Light Power for a darker image; increase it for a lighter image.
Generally, use Light Power to maximize the contrast of the mark relative to the
background on the wafer.

NOTE The effect of the Light Power setting is visible in the duration of the “strobed” light pulse as the
wafer reader acquires an image.
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3.5.11 Character Spacing

When ‘Chars, SEMI’, ‘Chars, IBM’ or ‘Chars, Triple’ is the selected Mark, the Character
Spacing setting controls the tolerance of the spacing between adjacent characters and
the vertical alignment of the characters.

NOTE  The current Character Spacing setting is used during tuning (Section 3.5.16).

SELECTION DESCRIPTION

Standard Spacing Reads the characters using standard SEMI specifications for character spacing and vertical
character alignment.

Relaxed Spacing Reads the characters with more tolerance for deviations from the specifications for character
spacing and alignment.

3.5.12 Color

The Color setting specifies the expected color of the wafer mark. In-Sight automatically
determines the correct color of the mark as imaged during the tuning process if the Color
checkbox in the Tune dialog is enabled.

SELECTION DESCRIPTION
Black Specifies a black mark on a light background. Use when Light Mode is set to Bright Field.
White Specifies a light mark on a dark background. Use when Light Mode is set to Dark Field.

NOTE The Color setting is ignored when the selected Mark is a barcode.

3.5.13 Retry

The Retry drop-down list specifies the tuning behavior of the Config during the retry
sequence at runtime. The retry order for Configs is specified in the Options tab (see

Section 3.6).
SELECTION DESCRIPTION

Disable (default) The Config will be tried, but not fine tuned*; fine tuning differs from the more exhaustive tuning
process during setup (see Section 3.5.16).

Enable The Config will be tried, and fine tuned.

Enable & Apply The Config will be tried and can be fine tuned. If tuned successfully the new settings will be
applied to the Config, overwriting the previous settings.

*Fine tuning adjusts the Light Power by + .5ms, in increments of .2ms. It also adjusts the Size region + 1 pixel, both high and wide.

This continues on all enabled Configs until there is either a read or the timeout is exhausted.

NOTES

m Enabled must be checked for a Config to be included in the retry sequence, regardless of the Retry
selection.

m If Retry is enabled for multiple Configs that have identical settings, only one Config will be retried.

m The Retry setting is ignored when the In-Sight protocol TUNE(<Config>) command is issued.
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3.5.14 Region

The Region defines the area in which the wafer mark is expected to appear in the FOV.
The mark must be sufficiently illuminated and entirely contained within the Region or the
read will fail. Generally, the mark may be rotated as much as + 5 degrees within the
horizontal axis of the region without a significant decrease in readability. The image
coordinates and the size of the region (row, column, height, width) are displayed below
the box. If a rotation or curve is set for the Region, the Theta (rotation) and Phi
(curvature) are also displayed.

To set the Region:

1 Click the Edit Region button. The image area will expand, and the interactive region
box will appear (Figure 3-6).

File [Setup  |Options |Run |

Save | Cancel | ILiwe Zoom |1DD% 'I

Eead | String |

Host: 192.168.0.1 Access: Full Current User: admin Admin/Operator: admin

Figure 3-6: Editing the Region

2 Adjust the region as necessary to encompass the entire mark.

= To move the region, position the +* cursor anywhere inside the box, then click
and hold the left mouse button while dragging. To move the region one pixel at a
time, use the arrow keys on the keyboard.

= To resize the region, position the cursor over an edge or corner of the region,
then click and hold the left mouse button while dragging. To resize the region one
pixel at a time, use Shift-arrow keys.
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To rotate the region, press CTRL+R on the keyboard. In the upper left-hand
corner of the region, the rotate region icon, Q’ will appear. When the cursor

moves over the icon, it changes to the rotate region cursor, —|_ Click and drag
the rotate region cursor with the left mouse button to rotate the region. To rotate
the region one pixel at a time, use the CTRL+Left/Right arrow keys. The region
can be rotated +180 degrees. When rotating the region, the angle setting is
displayed along with the other region settings. The mark must still be within +5
degrees of the horizontal axis of the region.

To curve the region, press CTRL+R on the keyboard. In the upper right-hand
corner of the region, the curve region icon, ", will appear. When the cursor

moves over the icon, it changes to the curve region cursor, '\[tn) Click and drag
the curve region cursor with the left mouse button to curve the region. To curve
the region one pixel at a time, use the CTRL+Up/Down arrow keys. The region
can be curved 360 degrees. When curving the region, the curve setting is
displayed along with the other region settings. The mark must still be within £ 5
degrees of the horizontal axis of the region.

NOTES

The Zoom function can be especially useful when setting the Size.

When 2D Sym, T7 Data Matrix' is the selected Mark, the Region must be set no larger than 120
pixels high. If the Region height is set larger than 120 pixels, the read will fail. Also, setting the
region to an angle other than zero may lower the accuracy of the read.

Although the region can be rotated, it is strongly recommended that the wafer reader be mounted
so0 the mark aligns parallel to the horizontal image axis. Setting the region to an angle other than
zero will increase read time.

If both the rotation and the curve of the region are set to zero, only the image coordinates and the
size of the region (row, column, height, width) are displayed below the box.

To finish editing the region and accept the changes, double left-click anywhere in the
image or click the Save button above the image area.
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3.5.15 Size

Size defines the expected height and width of a 2D symbol or the characters in a string,
as measured in pixels. The size (height, width) is displayed below the box.

NOTES

m  WhenaBC 412 or IBM 412 barcode is the selected Mark type, Size is disabled.

m The location and rotation of the Size are used for positioning only; they do not effect the read. Also,
the default rotation angle is set to the Region’s rotation angle.

m The Zoom function can be especially useful when positioning the Size region.

To set the mark size:

1

2

34

Click the Edit Size button. The image will automatically expand.

To move the Size, position the 1 cursor inside the size box, then click and hold the
left mouse button while dragging. To resize the box, position the cursor over an edge
or corner of the box, then click and hold the left mouse button while dragging. To

rotate the Size, press CTRL+R on the keyboard. Click and hold the left mouse button
while dragging the circle to rotate the region. The region can be rotated +45 degrees

TIP To move the region one pixel at a time, use the arrow keys on the keyboard, to resize the
region one pixel at a time, use Shift-arrow keys and to rotate the region one pixel at a time,
use the CTRL+Left/Right arrow keys.

m  [f ‘Chars, SEMI’, ‘Chars, IBM’ or ‘Chars, Triple’ is the selected Mark, Size defines
the height and width expected for each character in the string. To set the size for
characters, position the Size box around a character so that its edges align with
the centers of the strokes, as shown in Figure 3-7. “Square” characters with
horizontal and vertical strokes — such as 0, 3, and ® — are the best to use when
setting the size, although any character can be used.

Figure 3-7: Editing Character Size (Enlarged)

m  [f 2D Sym, T7 Data Matrix’ is the selected Mark, Size defines the height and
width expected for the entire 2D symbol. To set the size for 2D symbols, position
the Size box so that it aligns with the centers of the corner cells of the matrix, as
shown in Figure 3-8.

Figure 3-8: Editing 2D Data Matrix Size (Shown at 200% Zoom)
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To finish editing the box and accept the changes, double left-click anywhere in the image,
or click the Save button.

3.5.16 Tune

The Tune button accesses the automated tuning process used to optimize Config
settings (see Figure 3-9). Unlike Retry tuning, standard tuning is performed on an
individual Config prior to runtime.

During tuning, an exhaustive read test is performed on the mark using combinations of
Color, Light Mode, Light Power and Size settings with the current settings for the Mark,
Checksum, Accept, Character Threshold, Field String/Definition, Character Spacing and
Region settings. After each iteration, the string and score results for the last read are
displayed. The best string and score result achieved so far are shown, along with counts
of the total number of reads attempted and the number of successful reads.

NOTES
m  Either the Light or Size checkbox must be enabled to tune the Config.

m  The image display is not updated during tuning.

File |Setup  [Options [Run |

Expandlriane | Arruire | LLje | Zoom |1DD% vl

Config0 |Config 1 [Config 2 [Config3 [Config4 ['Configs [Conig 6 [Config 7 [Config 3 [Config 8 |

String.  KESS0FA4CGCD Passed: 69
Score: 389 Tried: 155

Accept |
RESEL |

Back |

Read | String [HEBS0FA4CGCD Score [399

Host: 192.168.0.1 Access: Full Current User: admin Admin/Operator: admin

Figure 3-9: Tuning a Character String

When tuning is completed, the combination of settings that correctly read the mark with
the highest score is retained, and can be applied to the Config or discarded.
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To tune a Config:

Choose the tune options to try by enabling/disabling the checkboxes. By default, Color,
Light and Size are enabled. Disabling a checkbox causes tuning to use the current
definition for the corresponding setting in the Config.

m  When the Color checkbox is enabled, both black and white mark colors are tried
during the tuning process.

= Light Mode and Light Power are automatically tuned if the Light option is
enabled. If the Light option is disabled, the current Config settings for Light Mode
and Light Power are used.

= When the Size option is enabled, tuning will try sizes £ 10 pixels from the current
Size setting in the Config.

During tuning:

= Click Pause to pause tuning. Click Continue to resume tuning from where it left
off.

= Click Accept to stop tuning and update the Config with the settings of the best
read so far (the Accept button will be grayed out until the first passed read).

= Click Reset to stop tuning and discard the tuning results.

= Click Back to stop tuning, discard the tuning results, and return to the Config
settings.

After tuning is completed:

= Click Accept to apply the tuned settings to the Config.

= Click Reset to re-initialize all tuned settings. Select a different combination of
tuning options, then click the Start button to tune again.

= Click Back to return to the Config settings. The Config will be updated with the
tuned results if Accept was clicked previously. Otherwise, the tuned settings will
be discarded.

TUNING TROUBLESHOOTING TIPS

m  Make sure the Field String contains the correct number of characters, and any dots, dashes, and
spaces are in the correct positions.

m  Make sure the correct Checksum is selected (for Chars).

m  Make sure Region and Size settings are reasonable before tuning.

3.5.17 Read

The Read button, below the Config settings, acquires an image and performs a “test”
read on the wafer mark using the current Config. The String and Score results are
reported to the right. If the read passes, the String appears on a green background; failed
reads appear on a red background.
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3.6 Setting Options

The selections in the Options tab (Figure 3-10) control how the configured wafer ID
application will operate during runtime.

File Setup Options THun 1
System
Read
Fead Timeout [zac) 30 I Dizable Acquire
[ Show Dutput Graphics

Riead Drdsr Last Best j [ Autoscore NonAlphanumeric

Input 7 Output

Trigger Metwark j Pratacol In-Sight j [ Output String [~ Dutput Passed

Output Destination Metwork j Port 2000 [~ Output Score

Logging

Host Mame Syztem User AN0NYMouE [V Output String [ Output Paszed

File Mame InSight Pazzword [~ Output Score [ Output Failed Image
Host: 152 168.0.1 Access: Ful Current User: admin Admin/Operator: admin

Figure 3-10: Options Tab

3.6.1 Read

Read options control the try sequence for enabled Configs. Optionally, image acquisition
can be disabled to allow test reads from image files when the wafer reader is Offline.

Read Timeout & Read Order

Read Timeout specifies the total amount of time (up to 60 seconds) to allow for a read,
including retries and tuning of enabled Configs. When the timeout limit is reached without
a successful read, the read fails.

NOTE Specifying a Read Timeout differs from terminating the execution of the read using the Abort
Execution command. For more information on this command, refer to Section 7: Native Mode
Commands.
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In-Sight® 1700 Series Wafer Reader

Read Order Specifies the order in which enabled Configs will be tried until a successful

read is obtained.

SELECTION DESCRIPTION
Last Best Configs will be tried in the order they scored (from highest to lowest) during the last read until a
(default) passed score is read.
In Order Configs will be tried in numerical order (0-9), regardless of how they scored during the most recent

read.

Disable Acquire

Disables image acquisition to allow a test read from the last image acquired, or from an
image file, when the wafer reader is Offline. The Light Mode and Light Power settings are
disabled, as are the Acquire and Live buttons.

To Read from a Saved Image File:

1 Check the Disable Acquire checkbox.
2 Load a valid .BMP or .JPG image file (640 x 480, 8-bit) using one the following

methods:

= With the In-Sight PC Host open, drag-and-drop an image file onto the
spreadsheet. Or, open the Save & Load dialog (System > Save & Load) and
select an image from a different In-Sight host on the network.

= Open an FTP connection to the wafer reader (for instructions see Appendix A:
Updating the Wafer Reader’s Firmware). Drag-and-drop the image file into the
FTP window of the web browser, or use the mput command from an FTP

prompt.

NOTE You do not need to rename the image file before loading it on the wafer reader. The wafer
reader will automatically copy the .BMP or .JPG file to the built-in file names, IMAGE.BMP or
IMAGE.JPG, respectively.

Click the Read button on either the Setup or Run tab to read from the image file.

Repeat step 2 to read from a different image file, or uncheck Disable Acquire in the
Options tab to return the wafer reader to normal operation.

COGNEX




In-Sight® 1700 Series Wafer Reader Section 3: Configuring a Wafer ID Application

Show Output Graphics

When the Show Output Graphics checkbox is enabled, the character’s score, the read
character, and the center coordinate of the character are displayed in the image area. If
the mark passes, the output graphics are shown in green; if the score is below the Accept
value, the output graphics are shown in red. If a character cannot be read, a question
mark is displayed. If the mark fails, and the character’s score is above the Accept value,
the output graphics for the character are shown in green. An example with Output
graphics enabled is shown in Figure 3-11.

NOTE  Output Graphics are only shown when the selected Mark is ‘Chars, SEMI', ‘Chars, IBM’, or ‘Chars,
Triple’.

H

g5,

Figure 3-11: Output Graphics

Autoscore Non-Alphanumeric (In-Sight 1721/1722 Only)

When the Autoscore Non-Alphanumeric checkbox is enabled, character positions fielded
as dashes (-), dots (.) and spaces automatically score 100 points, rather than a weighted
score based on the quality of the read.

NOTE The Autoscore Non-Alphanumeric option is only available for ‘Chars, SEMI’, ‘Chars, IBM’ and
‘Chars, Triple’ Marks.

3.6.2 Input/Output

Input/Output options control how reads are initiated on the wafer reader, and the data
format of the output results.

Trigger
Selects the source of the trigger that acquires an image and initiates a read.
SELECTION DESCRIPTION
Camera Reads when the acquisition input on the wafer reader receives a pulse from an external trigger
source.
Network Reads when the READ command is received from a remote network host through a TCP/IP
(default) device connection at the specified Port.
Serial Reads when a READ command is received from a remote RS-232 serial device.
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NOTE When ‘Serial’ is the selected Trigger, the Mode setting in the Serial tab on the System Settings
page must be ‘Text' (see Section 6.4: Configuring Serial Port Settings).

Output Destination

Determines where results are sent after each read.

SELECTION DESCRIPTION
Network Sends read results to a remote network host through a TCP/IP device connection at the specified
(default) Port.
Serial Sends read results to a remote RS-232 serial device.

NOTE When ‘Serial’ is the selected Output Destination, the Mode setting in the Serial tab on the System
Settings page must be ‘Text’ (see Section 6.4: Configuring Serial Port Settings).

Protocol

Determines the command that a remote device sends, and the format for outputting the
results data.

NOTE To trigger an event, the wafer reader must be Online.

Protocol commands can be used with either a TCP/IP or RS-232 connection, depending
on the Protocol. If used with TCP/IP, a valid Port number must be specified. When using
an RS-232 serial device, the settings in the Serial tab (see Section 6.4 Configuring Serial
Port Settings) should be configured to correspond with the serial device the wafer reader
will be communicating with. For example:

® Baud Rate = 115200

® DataBits=8

®  Stop Bits =1

®  Parity = None

® Handshake = Xon/Xoff
®  Mode = Text

NOTE If using the Send Message Native Mode command, the selected Mode must be Native. For more
information on the Send Message command, refer to Section 7: Native Mode Commands.
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Also, the Text Mode settings in the Text Mode Details dialog should be configured as
shown in Figure 3-12. To access the Text Mode Details dialog, click on the Details

button on the Serial tab.

®  Fixed Input Length = 6

®  Input Terminator = 13

®  Qutput Terminator = 13

In-Sight Protocol

¥ Fixed Input Length

Input Terminatar

Cutput Terminator

Cancel

—
En
6

|Warning: Applet \Window

Figure 3-12: Text Mode Details Dialog

In-Sight is the default protocol for the wafer reader. This protocol can be used with either
a TCP/IP or RS-232 connection.

COMMAND

DESCRIPTION

OUTPUTS

READ(<Config>)

Reads the specified Config (0 - 9).

Note: To execute a read of all enabled Configs,
send the READ command, setting the <Config>
input to "-1".

READ

Reads all enabled Configs. This command uses
the Read Order selected in the Options tab. If the
READ command needs to be terminated before
the Read Timeout is exhausted, the Abort
Execution Native Mode command can terminate
the READ execution.

TUNE

Tunes the specified Config (0 - 9). Each time the
TUNE command is sent, the Power is adjusted by
+.5ms, in increments of .2ms, and the Size
region is adjusted % 1 pixel, both high and wide.

For all In-Sight Protocol commands, the
Output String is a character string for a
successful read. For failed reads, the output
is either a string of asterisks (***) or a partial
read (where unreadable characters are
returned as question marks). The type of
output is dependent on the score (see
Section 5.1.6: Score).
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An example of the outputs using the In-Sight protocol commands from Microsoft

Windows' built-in Telnet client are shown in Figure 3-13.

% Telnet is1721_00060b =

READCA>
REBSAFA4CGCH. 397 .8008.1 .688
TUNE<A>

“EBSAFA4CGCH. 396 .8068 .1 .068
READC1 »

EEIFTIBJSEFH 4CGCY.46 . 808 . 8. 8484
REBSAFA4CGCH. 397 .8008.1 .688

Figure 3-13: In-Sight Protocol Output Example

EG (Electroglas) Protocol

Protocol for use with an Electroglas, Inc. wafer prober. This protocol can be used with

either a TCP/IP or RS-232 connection.

COMMAND DESCRIPTION

OUTPUTS

ESC-y1wXON Reads all enabled Configs. This command uses
the Read Order selected in the Options tab.

Note: “ESC” and “XON” are control characters.

The Output String will be either a character
string for a successful read or a string of
asterisks for a failed read. Partial reads are
not returned, since any return other than a
string of asterisks will be interpreted by the
wafer prober as a successful read. The
number of asterisks returned will be the
same as the number of characters specified
in the Field String (see Section 3.5.6: Field
String and Field Definition).

An example of the outputs using the EG protocol commands from Microsoft Windows'
built-in Telnet client are shown in Figure 3-14. The first Read command (entered as a
sequence of ASCII characters) shows the output for a successful read; the second Read

command shows the output for a failed read.

2% Telnet is1721_00060b -

1wl
XEBSOFA4CGCA, 395 .0060,1.000
1wl

6363636 36 I I I I I I

Figure 3-14: EG Protocol Output Example
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The In-Sight wafer reader supports several Siemens LKx5 commands that allow the
wafer reader to be controlled from users’ custom application programs over an RS-232

connection.
COMMANDS DESCRIPTION
BC Request to read a barcode.
BC&OCR Request to read both the barcode and OCR string.
BC|OCR Request to read a barcode or OCR string.
DDM Request to read the 2D mark.
DDM&OCR Request to read both the 2D mark and OCR string.
DDM|OCR Request to read the 2D mark or OCR string.
NBC Request to read a barcode mark that does not match the OCR string.
NBC&OCR Request to read a barcode mark and OCR string where the two differ.
OCR Request to read an OCR string.
READ Request to read any mark in this order: OCR, DDM, BC.
ROT_KOMPR Request reading a barcode from right to left.
SET_HW Echoes the input argument. This command is provided for compatibility only; it does not
affect light settings.
VERS Request the firmware version of the wafer reader.
Port

Assigns the TCP/IP port number to use when ‘Network’ is selected in the Trigger or
Output Destination settings. This port number is where a TCP/IP connection is
established between the wafer reader (a TCP/IP server waiting for communication) and a
remote device (a TCP/IP client that initiates communication). The default port is 2000, but
any unused number between 1 and 65535 may be used, excluding 21, 23, 68, 80, 502,
1069, 1070, 1212, 2222, 44818 and 50000 (reserved for In-Sight communications).

Output String, Output Score, Output Passed

These checkboxes select the results data that will be sent to the Output Destination after
a read. By default, only the Output String box is checked. When the Output Passed
checkbox is enabled, the resulting data is either a *1.000’ if the read passes or ‘0.000’ if
the read fails.

3.6.3 Logging

Read results may be written to a log file saved on a network host. Logging options
specify which results are written to the log file.

Host Name

The name or IP address of the remote host on the network where the log file will be
created.

File Name

The name of the file on the specified host where log entries will be appended. The log file
is an HTML document; the .HTM extension is automatically appended to the File Name.
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This file is saved in the default FTP directory; subdirectories cannot be specified. The
maximum File Name length is 64 characters.

User

A valid User name for the specified host.
Password

A valid password for the User on the specified host.

Output String, Output Score, Output Passed, Output Failed Image

These checkboxes select the results data that will be written out to the HTML file on the
specified host. The following results can be logged:

®  Qutput String

®  Qutput Score

®  Pass/fail status of the read
®  The image, if the read failed

Data is appended to the specified log file. A bitmap file containing the failed image is also
stored on the specified host. A hyperlink to the failed image is included in the log file.

The wafer reader must be Online for data to be appended to the log file. The log file must
be reset manually by deleting, renaming or moving the current .HTM file, or by specifying
a new file name for the log file. An example of the HTML log page, with all outputs
selected, is shown below.

ghtyIn-Sight Exph mulatorifilename. htm

78 C:\Program
File Edit View Favortes Toolz Help |ﬁ

Q G B >

Search  Favortes  History

= .= @3 B A

Back Fanward Stop Refresh Harmme

AerESSIC:\ngram Files)Cognes\In-Sight|In-Sight Explorer 3.x.x\EmuIatnr\fiIaname.htmj 6)50 | Links **

o HER20FA4CGCN,398.000,1.000 -
o HXER30FA4CGCN,398.000,1.000

o HEB40FA4CGCO,3598.000,1.000

o HERS0FA4CGCH,398.000,1.000

o HESS0FA4CGC,398.000,1.000

o FIH3CQEERS0F?,67.000,0.000 flename001 bimp

o HERTOFA4CGCO,398.000,1.000

o JMESB0FA4CGC,398.000,1.000

o HERSOFA4CGCO,3598.000,1.000

=l
& T St

Figure 3-15: HTML Log Page Example
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4.1 About Job Files

The File tab (Figure 4-1) provides access to job files stored in flash RAM on the wafer
reader.

File [ setup [options | Run |

Qpen... |
Save |
Save As.. |
[melete |

FTP CurrentJob;  ¥WaflDOO job

Applet Verzion: 3.20.05

Host: 152168.0.1 Access: Full Current User: admin AdminiOperator: admin

Figure 4-1: File Tab

The default job file is WAFIDO0O.job. To use the browser interface, at least one job file
must be stored on the wafer reader. This can be the default job or any compatible job that
has been saved using the browser interface. The File tab also lists the job currently being
used by the applet; this job cannot be deleted.

NOTE A WAFIDOOBC.job file is also loaded on the wafer reader. This job file is identical to the default
WAFID00.JOB, except the default mark type is BC 412.
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To connect to an In-Sight wafer reader from the browser interface, the wafer reader's
Startup settings must be configured to automatically load the default job, or another job
that has been previously saved using the browser interface.

Advanced users may customize some cells in the spreadsheet of a browser interface-
compatible job. In general, cells may be safely added to the spreadsheet. However, the
predefined functions and formulas in the spreadsheet must not be rearranged, deleted or
otherwise changed in such a way as to break compatibility with the WAFID00.JAR Java
applet. Under no circumstance should the cells in Rows 21 through 74 ever be modified.
These rows are hidden by default.

4.2 Saving Jobs

Jobs must be saved on the wafer reader to preserve changes made to Config and
Options settings. If the job is not saved, all settings changes will be lost when a new job
is opened or the power is cycled on the wafer reader.

To save a new job:

1 Click on the File tab.
Click the Save As.... button.

Enter a new file name (do not include a directory or subdirectory) in the Save As...
dialog. Job file names can contain up to 15 characters (the .JOB extension will be
added automatically).

4 Click OK to save the Current Job to a new job file, or Cancel.

To save changes to an existing job:

1 Click on the File tab.
2 Click the Save button.
3 Click OK to save the Current Job, or Cancel.

4.3 Opening Jobs

Only job files stored in the wafer reader’s flash memory can be opened using the browser
interface.

To Load an Existing Job from In-Sight Wafer Reader Memory:
Click on the File tab.

Save changes made to the Current Job, if needed.
Highlight a job file in the list.

Click the Open button.

Click OK in the Open File dialog to load the job, or Cancel.

a b WO N =
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4.4 Sharing Jobs Between Readers

A job file saved on one wafer reader may be shared with other wafer readers on the
network using FTP to copy the file.

4.5 Changing the Startup Job

By default, the wafer reader is configured to load the WAFID00.JOB automatically after
receiving power. However, after making changes to Config and Options settings and
saving to a different job file, you will want to configure the wafer reader to automatically
load and run that new job at startup.

To change the default startup job for the wafer reader:

1 Click on the Options tab.

2 Click on the System link in the upper-right to access the wafer reader’'s System
Settings.

Click the Startup tab.
Select a new job file to load on startup from the Job list.
Click the Save button.
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5 Running the Job

In this section...

5.1 The Runtab

5.1 The Run tab

The Run tab is the only view of the wafer reader available from the browser interface
during runtime operation.

File [Setup [options  [Run ]

Expand Image | Zoom |1DD% 'l ¥ [Criline

Read Log Config Attempts Passed Failed Response Avg
Trying Config 0 "XESS0FASCGAS™ (74) ;[ i] 45 14 1 91.7
Trying Config 1 "XESS0FABCGAD™ (153) 1 36 35 1 89.3
Trying Config 2 "XESS0FASCGAD™ (396 2 29 27 2 a7.7

PASSED

Trying Config 0 "XESS0FAACGCE™ (75)
Trying Config 1 "XE&S0FAACGCO™ (184)
Trying Config & "XEG50FA4CGCOT (396)

PASSED 1
;l Overall 110 106 4 32.0
Fead | StrinngEBSDFMCGCD Score |396 EEsel Stats |
Host: 192.168.0.1 Access: Full Current User: admin AdminiOperator: admmin

Figure 5-1: Run Tab
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The following sections describe the information displayed in the Run tab.

5.1.1 Online Checkbox

The Online checkbox at the top-right of the Run tab switches the wafer reader between
its Online and Offline modes of operation. When this checkbox is enabled (the default
setting), the wafer reader is “Online”. The File, Setup, and Options tabs are grayed out,
and the following operations are supported:

= Qutput read results data to the log file specified in the Options tab.

= Qutput read results over the serial port when Serial is the selected Output
Destination in the Options tab.

= Respond to the protocol’s READ and TUNE commands.

= Respond to the camera, network, and serial acquisition Trigger selected in the
Options tab.

m  Send/receive data to and from the spreadsheet over the network or serial port
using the Input/Output functions.

NOTE If the Online checkbox is enabled from the browser and a System Offline dialog appears, open the
PC Host and verify that the PC Host's status bar indicates the wafer reader is Online, then click OK
to close the dialog.

When the Online checkbox is disabled, the wafer reader is “Offline”. When the wafer
reader is Offline, the following actions are allowed:

m  Edit settings in the Setup and Options tabs.

= Save and open jobs in the File tab.

= Manually acquire an image and read the wafer mark using the Read button.
m  Clear all read results using the Reset Stats button.

m  Execute Native Mode commands over telnet.

The wafer reader’s Online state is a combination of three independent flags:

m  Spreadsheet flag — Set directly from the System menu’s Online checkbox in the
In-Sight spreadsheet. This flag can also be controlled by the Online checkbox in
the Startup tab (see Section 6.6). For the browser-based user interface to run
properly, this flag should be enabled.

= Native Mode flag — Set from the Online checkbox in the Run tab or from the Set
Online Native Mode command (see Section 7).

= Discrete I/O flag — Not used by the wafer reader; enabled by default.

The wafer reader is Online only when all three flags are enabled.
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5.1.2 Read Log

A record of the most recent read results. This log returns the string, score, and pass/fail
status of each Config that is read or retried.

NOTE  If the wafer reader is Offline, a continuous log is displayed. If the wafer reader is Onling, only the
last read results are displayed.

5.1.3 Statistics Window

A statistical record of the read results.

NOTE Any changes to a Config's settings will reset the statistics for that Config, but do not change the
overall statistics.

Config

The index of each enabled Config.

Attempts

The number of times the Config has been used during reading.
Passed

The number of times the Config read successfully.

Failed

The number of times the Config failed to read.

Response Avg

The average raw response score of all attempted reads for the Config.
Overall

The cumulative statistics from the results of all reads.

NOTES
m The Overall statistics are calculated independently of the statistics for the individual Configs.

m [f Retry is enabled from the Setup tab, the Attempts, Passed and Failed statistics do not reflect any
retries.

5.1.4 Read

The Read button acquires an image and reads the wafer mark. The String and Score
results are reported to the right. The Read button is grayed out when the Online
checkbox in enabled.
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5.1.5 String

The character string result for the last read. If the read passes, the string appears on a
green background.

Failed reads appear on a red background. If a failed read’s score is above the minimum
threshold for reporting results, individual string characters are displayed. Any character in
the string that cannot be read is displayed as a question mark. If the failed score is below
the minimum threshold, all characters are shown as asterisks. The number of asterisks
returned will be the same as the number of characters specified in the Field String (see
Section 3.5.6: Field String and Field Definition).

5.1.6 Score

The score for the last read. For more information on scoring, see Sections 3.5.5 and
3.5.7.

5.1.7 Reset Stats

The Reset Stats buttons clears all results in both the Read Log and Statistics windows.
The Reset Stats button is grayed out when the Online checkbox in enabled.
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6.1 About System Settings

Each wafer reader has its own system settings that control the wafer reader’s networking
configuration and serial port settings, the list of authorized users, and the startup
behavior. These settings are stored in the wafer reader's PROC.SET file, and apply to all
jobs.

To access a wafer reader’s System Settings from the browser interface:
1 Click on the Options tab.

2 In the Options tab, click on the System hyperlink in the upper-right corner.

NOTE System Settings may also be configured using the In-Sight PC Host.
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6.2 Version Information

The Info tab shows important information about your wafer reader and its current
firmware and applet version. This information is needed if assistance is ever required
from Cognex Technical Support. The Online checkbox at the top-right of the Run tab
switches the wafer reader between its Online and Offline modes of operation. For more
information about the Online checkbox, see Section 5.1.1. The Back hyperlink, located
below the Online checkbox, returns you to the Run tab.

Info TNetvmlk TSeliaI TUser List TStaltup ]
[ Online
Serial Number F112301132 Back
Firmware Yersion 320,05
Monitor Yersion NA&
Mac Address 00-d0-24-00-06-0b
Build Date May 16 2008, 16:41:21
Applet Yersion 3.20.05
Host: 192 168.0.1 Access: Full Current User: admin Admin/0perator:

Figure 6-1: Info Tab

6.3 Configuring Network Settings

The Network tab (Figure 6-2) configures an In-Sight wafer reader to be used on a
network.

Info TNetwolk TSeriaI TUSEI List TStaltup ]

IP Address 13z [ea o 1 Host Name  [is1721_0006(0h FTP Settings
Subnet Mask ’ﬁ ’ﬁ ’D_ ’D_ Diomain wourdomain. com
Drefaulk Gateway ’U_ ’U_ ’U_ ’U_ Save

DMS Server ’U_ ’U_ ’U_ ’U_ [ Use DHCP Server

Host: 182 168.0.1 Access: Ful Current Uger: admin Admin/Operator:

Figure 6-2: Network Tab
Use DHCP Server

The Use DHCP Server checkbox determines whether the wafer reader uses DHCP
(Dynamic Host Configuration Protocol) on start up or if the values in the Network tab
configure TCP/IP.

NOTE This box should be checked only if a DHCP server is running on the local network. If the box is
checked and a DHCP server does not respond within 60 seconds, the wafer reader will boot
without network support enabled.
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All of the settings that can be configured in the Network tab depend on whether this
checkbox is enabled. If enabled, the checkbox allows the wafer reader to be configured
automatically by a DHCP server at startup. Optionally, a new Host Name may be
assigned, but all other fields in the Network tab will be grayed out.

However, if the Use DHCP Server checkbox is disabled, the network settings

for the wafer reader must be configured manually. If the wafer reader was previously
assigned an IP address using DHCP, disabling the Use DHCP Server checkbox will use
the same |IP address.

In production environments, a static IP address should be used instead of DHCP. Using a
static IP address removes the need for a DHCP server on the local network and
eliminates extraneous DHCP traffic.

IP Address

Assigns a unique identifier for each wafer reader on the network, which must be
consistent with the IP address-numbering scheme of the local network.

NOTE The IP Address setting is grayed out when the Use DHCP Server checkbox is enabled.

Unlike the factory-assigned MAC address, the IP address is assigned automatically by a
DHCP server or must be manually assigned by the user. The following IP addressing
schemes are recommended:

ADDRESSING SCHEME DESCRIPTION

10.0.0.0/8 The 10.0.0.0/8 private network is a class A network ID that allows valid IP addresses from 10.0.0.1
to 10.255.255.254. The 10.0.0.0/8 private network has 24 host bits which can be used for any
subnetting scheme within the private organization. The default Subnet Mask is 255.0.0.0.

172.16.0.0/12 The 172.16.0.0/12 private network can be interpreted either as a block of 16 class B network IDs
or as a 20-bit assignable address space (20 host bits) which can be used for any subnetting
scheme within the private organization. The 172.16.0.0/12 private network allows valid IP
addresses from 172.16.0.1 to 172.31.255.254. The default Subnet Mask is 255.255.240.0.

192.168.0.0/16 The 192.168.0.0/16 private network can be interpreted either as a block of 256 class C network
IDs or as a 16-bit assignable address space (16 host bits), which can be used for any subnetting
scheme within the private organization. The 192.168.0.0/16 private network allows valid IP
addresses from 192.168.0.1 to 192.168.255.254. The default Subnet Mask is 255.255.0.0

Subnet Mask

Defines which part of the wafer reader’s IP address refers to the network and which part
refers to the host.

NOTE When DHCP is enabled, this field is grayed out and displays the value assigned by DHCP.
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The network part of the IP address is the same for all hosts on the same subnet, and the
remainder is unique to each host. As shown in the table below, a Subnet Mask of
255.255.255.0 (a class C mask) identifies 24 bits for the network portion and 8 bits for the

host portion.
CLASS SUBNET MASK NETWORK ADDRESS HOST ADDRESS
A 255.0.0.0 8 bit 24 bit
B 255.255.0.0 16 bit 16 bit
c 255.255.255.0 24 bit 8 bit

Default Gateway

Specifies the IP address of the gateway host, if available on the network.

NOTE The Default Gateway setting will be grayed out when the Use DHCP Server checkbox is enabled.
The value shown is the gateway assigned by the DHCP server.

The gateway host is responsible for sending and receiving data between hosts on
different networks, routing data packets from a device on the local subnet to a device on
another subnet.

For example, if a wafer reader will need to communicate with a remote host on a different
subnet, enter the address of the gateway device in the Default Gateway field. However, if
the wafer reader will need to communicate only with devices on the local subnet, do not
enter an address for the Default Gateway (leave the field all zeros).

DNS Server

Specifies the IP address of the host on the network providing DNS resolution, if available.

NOTE The DNS Server setting will be grayed out when the Use DHCP Server checkbox is enabled. The
value shown is the DNS Server assigned by the DHCP server.

A Domain name (i.e., yourdomain.com) is an alias for an IP address (i.e., 192.168.0.1). A
DNS (Domain Name Server) maintains the data on corresponding domain names and IP
addresses. The DNS Server setting determines which host is contacted (by IP address)
in response to a given Domain Name.

Host Name

Assigns a name, or “alias” for the wafer reader, as it will appear when browsing the
network using the In-Sight PC Host. Each wafer reader has its Host Name set
automatically the first time it boots. For example, an In-Sight 1721 wafer reader's Host
Name is "is1721_xxxxxx"; an In-Sight 1701 wafer reader’'s Host Name is
"is1701_xxxxxx". For every wafer reader, "xxxxxx" is given by the last 6 characters of the
wafer reader's unique MAC address. For example, an In-Sight 1721 wafer reader with the
MAC address 00-d0-24-00-06-0b will be assigned the Host Name, "is1721_00060b".

NOTE The Host Name setting is not automatically assigned by the DHCP server (if used) or referenced
through the DNS server. If the Use DHCP Server checkbox is enabled and the DHCP server
supplies the Host Name, it is ignored in favor of the default Host Name or the name entered by the
user.
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Domain

Specifies the wafer reader’s Fully Qualified Domain Name (FQDN) for the network on
which it is installed.

NOTE  When the Use DHCP Server check box is enabled, this field is grayed out and displays the value
assigned by the DHCP server.

The wafer reader must have a FQDN to be accessible from a remote host that is not part
of the local network. The Domain setting sets the string that is appended to the Host
Name to make a FQDN.

For example, setting Domain to yourdomain.com yields the following results:

m [f a Host Name is is1721_00060b, the FQDN for lookup is
is1721_00060b.yourdomain.com.

= [f a Host Name is is1721_00060b.yourdomain.com. (notice the period at the
end), the FQDN for lookup is is1721_00060b.yourdomain.com.

Appending the period to the end of the Host Name prevents redundancy in appending the
Domain name to the FQDN. For example, if the period is omitted,
is1721_00060b.yourdomain.com would become
is1721_00060b.yourdomain.com.yourdomain.com).

FTP Settings

This button opens the FTP Settings dialog to configure the File Transfer Protocol (FTP).
FTP Settings dialog controls include:

= |Idle Timeout: The amount of time (in seconds) that a connection from another
host may be left open without any activity. The default is 120 seconds.

= Read Timeout: The amount of time (in seconds) that FTP remains blocked in a
read (or write). This value is used to recover from an unresponsive peer. The
default is 120 seconds.

m  Connection Retry: The number of times to try connecting to a peer. The default
is 1 try.

m  Local Port: The port address at which the local FTP server awaits connections.
The default port is 21.

= Remote Port: The port address at which a remote FTP awaits connections. The
default port is 21.

m  Passive Transfers: This checkbox enables "passive" FTP client transfers, which
may be required when In-Sight needs to access an FTP server through a firewall
that does not allow connections to be initiated from the outside. The checkbox is
OFF by default.
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Host Table

This button opens the Host Table dialog to specify a local mapping of network Host
Names to IP addresses. Host Table dialog controls include:

= Favor Host Table over DNS: When enabled, this checkbox specifies that the
search order for In-Sight Host Names will be the host table, followed by the
network browser, then DNS. When disabled, the Host Name search order is the
network browser, followed by DNS, and then the host table.

= Host Name: The name of the networked In-Sight wafer reader to map (or assign)
to the specified IP address. The Host Name entered will appear in any list of Host
Names throughout the In-Sight interface.

m |P Address: The IP address of the networked In-Sight wafer reader to map to the
specified Host Name.

6.4 Configuring Serial Port Settings

The Serial tab (Figure 6-3) configures the wafer reader's RS-232 serial port
communications.

Info Network |Serial  [User List [Startup |
¢ Port 0 Baud Rate I 115200 -] Handshake I Hardware =1
@ Part 1 Data Bits I8 hd I M ode INative - i
Stop Bitz |1 2 I Detailz |
Parity Inone 2 I
Host: 192.168.0.1 Access: Full Current User: admin Admin/Operator: admin

Figure 6-3: Serial Tab
Baud Rate
300, 600, 1200, 2400, 4800, 9600, 14400, 19200, 38400, 57600, or 115200 (default).
Data Bits
7 or 8 (default).
Stop Bits
1 (default) or 2.
Parity

None (default), Even, or Odd.
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Handshake

None, Xon/Xoff, or Hardware (default).

Mode

Sets the serial protocol to use.

SELECTION

DESCRIPTION

Text

Standard ASCII protocol for sending/receiving text strings. To define the input and output
terminator characters, press the Details button to open the Text Mode Details dialog. ‘Text must
be the selected Mode when Trigger and Output Destination are set to ‘Serial.

Native (default)

Custom ASCII protocol for controlling In-Sight from any remote host. To define the input and
output terminator characters, press the Details button to open the Native Mode Details dialog.

DeviceNet Protocol for communicating with Allen-Bradley PLC (requires an optional, RS-232-to-DeviceNet
Gateway adapter from Cognex). To define the input and output data packets sizes, press the
Details button to open the DeviceNet Details dialog.
Motoman Protocol for communicating with Motoman MRC, MRC-l, and XRC robot controllers operating in
DCI mode.
Unused Closes the serial port so that no commands or data can be received/sent.
Details

Opens the Details dialog for the selected Mode.

SELECTION

DESCRIPTION

Text Mode Details

The Text Mode Details dialog defines the terminator characters to use for Text Mode serial
communications. Text Mode Details dialog controls include:

B Fixed Input Length: Reads a fixed number of characters before triggering an event.

B [nput Terminator: The ASCII value interpreted by In-Sight as the end of an incoming string.
The default is 13 (carriage return).

B Qutput Terminator: The ASCII value that In-Sight adds to each output string to mark the end
of the transmitted string. The default is 13 (carriage return), and 0 specifies "no terminator".

Native Mode Details

The Native Mode Details dialog defines the terminator characters to use for Native Mode serial
communications. Native Mode Details dialog controls include:

®  Fixed Input Length: Reads a fixed number of characters before triggering an event.

®  |nput Terminator: The ASCII value interpreted by In-Sight as the end of an incoming string.
The default is 13 (carriage return), and 0 specifies "no terminator”.

B Qutput Terminator: The ASCII value that In-Sight adds to each output string to mark the end
of the transmitted string. The default is 13 (carriage return), and 0 specifies "no terminator".

DeviceNet Mode Details

The DeviceNet Mode Details dialog defines the terminator characters to use for The DeviceNet Mode
serial communications. DeviceNet Mode Details dialog controls include:

®  Input Packet Size: Sets the expected packet size to be received through the DeviceNet
Interface Module, in bytes. The setting must agree with the MaxWidth value in the RS-232-to-
DeviceNet configuration.

B OQutput Packet Size: Sets the packet size to send out through DeviceNet Interface Module, in
bytes. The setting must agree with the Transmit Width value in the RS-232-to-DeviceNet
configuration.

m  Trigger on First Byte: Triggers an acquisition when the first byte is received.
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6.5 Managing the User List

The User List tab (Figure 6-4) administers the access level and FTP read/write privileges
for authorized users of a wafer reader. The User List settings determine which users may
log onto a particular wafer reader using any of the available methods: browser interface
(HTTP), In-Sight PC Host, Telnet, and FTP. The User List also specifies the types of
configuration changes they can make. The User List is specific to each wafer reader and
is not shared between wafer readers; if a user needs access to a particular wafer reader,
they must know a User Name and Password that already exists in that wafer reader’s
User List.

Info TNelwmk TSeliaI TUSBI List TStarlup 1
User List
.
operatar User Mame Iadmln
monitor
Password I *****
Aocess IFuII - I
FTP v FRead  [¥l wiite
Host: 1582 168.0.1 Access: Full Current User: admin Admin/Operator: admin

Figure 6-4: User List Tab

6.6 Startup Options

The Startup tab (Figure 6-5) specifies job-related startup options for a wafer reader,
including the default job and Online/Offline status.

As described previously in Section 4.1, a wafer reader must have a job file loaded that is
compatible with the default job, WAFID00.JOB.

Hetwork TSeriaI T User List TStartup T\.-‘ersiun ]
Job w/aflD 00 job V¥ Orline Save |
TestO0.job

| TestOl job

Host: 1592.168.0.1 Access: Full Current User: admin Admin/Operator: admin

Figure 6-5: Startup Tab
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The wafer reader supports many Native Mode commands that allow the wafer reader to
be controlled from users’ custom application programs over Ethernet or serial port.

The Native Mode protocol is divided into two sets of commands: Basic and Extended.
Basic Native Mode commands are two characters long, plus parameters (if any) and a
terminator character; Extended Native Mode commands include additional functions or
commands. The commands are not case sensitive. The terminator is CR + LF (ASCII
characters 13 + 10) when sending Native Mode commands using a Telnet connection.
The default terminator is CR (ASCII character 13) when using Native Mode commands
over a serial port.

When a Native Mode command is remotely issued to an In-Sight wafer reader, the
In-Sight wafer reader processes the command and then returns a response, consisting of
an ASCII string followed by the terminator character. Commands that set values return 1
for "success", 0 for "unrecognized command", or a negative number for "failure".
Commands that get values return various values, depending on the command.

NOTES
m  Changes made using Native Mode commands are not reflected in the browser interface.

m  When logging on to an In-Sight wafer reader through Telnet from a Unix-based platform, the
In-Sight wafer reader's Host Name (or IP address) and port number (usually 23) must be added to
the command line. For example: >telnet is1721_00060b 23. Supplying the port number disables
the Unix username/password authentication and forces the Unix system to prompt you for user
name and password.
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Below is a partial listing of the Native Mode commands typically used to remotely control

the wafer reader.

BASIC NATIVE MODE COMMANDS

Abort Execution

Terminates the current execution of the WafID function within the spreadsheet.

Send Message

Sends an ASCII string to an In-Sight spreadsheet over a Native Mode connection, and
optionally, triggers a spreadsheet Event.

Set Online Sets the In-Sight wafer reader into Online or Offline mode.
PUT EXTENDED NATIVE MODE COMMANDS

Put Live Turns live acquisition on/off.

Put Portnum Specifies the Network Port used by In-Sight to transfer data and live images.

Put Watch Returns the data contained in the specified cell when the cell is updated.

EVALUATE EXTENDED NATIVE MODE COMMANDS (ACTIONS)

EV AcquireConfig Acquires an image using a Config’s light settings, but does not read.

EV CopyConfig Copies all settings and read results from the source Config to the target Config.

EV ReadConfig Reads using the specified Config.

EV TuneConfig Tunes a specific Config and optionally, saves the optimized settings.

EV TuneConfigEx Tunes a specific Config and optionally, saves the optimized settings.
Note: The TuneConfigEx command is only supported on In-Sight 1721/1722 wafer
readers with firmware version 3.20.05 and higher.

EV ResetStats Reset all accumulated read statistics.

EVALUATE EXTENDED NATIVE MODE COMMANDS (GET AND SET)

EV GetConfig Settings information for the specified Config.

EV SetConfig

EV GetConfigAccept The threshold Accept setting for a Config.

EV SetConfigAccept

EV GetConfigAvgScore The average raw response score of all reads that passed for a Config.

EV GetConfigBCType The index of the barcode setting for the specified Config.

EV SetConfigBCType

EV GetConfigBCHyphen

EV SetConfigBCHyphen

EV GetConfigBC3Digits

EV SetConfigBC3Digits

EV GetConfigCharHigh The settings information for the Size setting.

EV GetConfigCharWide

EV SetConfigCharSize

EV GetConfigChecksum The index of the Checksum selection for a Config.

EV SetConfigChecksum

EV GetConfigColor The index of the Color selection for a Config.

EV SetConfigColor

EV GetConfigEnable The status of the Enabled checkbox for a Config.

EV SetConfigEnable

EV GetConfigFieldDef The contents of the Field Definition setting for a Config.

EV SetConfigFieldDef

EV GetConfigFieldString The contents of the Field String setting for a Config.

EV SetConfigFieldString
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EVALUATE EXTENDED NATIVE MODE COMMANDS (GET AND SET)

EV GetConfigHigh The Size settings for a Config.

EV GetConfigWide

EV GetConfigLightMode The index of the Light Mode selection for a Config.
EV SetConfigLightMode

EV GetConfigLightPower The Light Power selection for a Config.

EV SetConfigLightPower

EV GetConfigMark The index of the Mark selection for a Config.

EV SetConfigMark

EV GetConfigNumFailed The number of failed reads for a Config.

EV GetConfigNumPassed The number of passed reads for a Config.

EV GetConfigNumTuneFailed

The number of failed reads during a tune for a Config.

EV GetConfigNumTunePassed

The number of passed reads during a tune for a Config.

EV GetConfigOrcChar The ASCII value of the indexed character in a read string.

EV GetConfigOrcCol The column coordinate of the indexed character in a read string.

EV GetConfigOrcRow The row coordinate of the indexed character in a read string.

EV GetConfigOrcVal The raw response score of the indexed character in a read string.

EV GetConfigOptimization The index of the Optimization setting for the specified Config.

EV SetConfigOptimization

EV GetConfigOrientation The index of the Img Orientation setting for the specified Config.

EV SetConfigOrientation

EV GetConfigPassed The pass/fail status of the specified Config for the most recent read.

EV GetConfigRegionRow The settings information for the Region setting.

EV GetConfigRegionCol

EV GetConfigRegionHigh

EV GetConfigRegionWide

EV GetConfigRegionTheta

EV GetConfigRegionPhi

EV SetConfigRegion

EV GetConfigResult The results of the most recent read performed by the specified Config.

EV GetConfigRetry The index of the Retry setting for the specified Config.

EV SetConfigRetry

EV GetConfigScore The score for a Config during the most recent read.

EV GetConfigString The character results for a Config during the most recent read.

EV GetConfigStringLen The number of characters contained in the result string.

EV GetConfigTheta The orientation of the mark for a Config.

EV GetConfigThresh The minimum response threshold for each individual character score.

EV SetConfigThresh

EV GetConfigTryLog The Retry status of the Config during the last read.

EV GetConfigTuneLog The Retry and Tune status of the Config during the last read.

EV GetMSBuffer The Machine Status data stored in one of 8 indexed buffers within the MachineStatus
stack. If the index is 0, the current Machine Status is returned.

EV GetWaferAcqEnable The status of the Disable Acquire setting.

EV SetWaferAcqEnable

EV GetWaferAll All results for the most recent read, and settings for all Configs.

EV GetWaferAllEx

All results for the most recent read, and settings for all Configs.
Note: The GetWaferAllEx command is only supported on In-Sight 1721/1722 wafer
readers with firmware version 3.20.05 and higher.

EV GetWaferAvgScore The average raw response scores for all Configs that passed.
EV GetWaferBestConfig The index of the Config that passed during the last read.

EV GetWaferFixCol The column coordinate of the fixture.

EV GetWaferFixRow The row coordinate of the fixture.
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EVALUATE EXTENDED NATIVE MODE COMMANDS (GET AND SET)

EV GetWaferFixTheta The orientation of the fixture.

EV GetWaferNumFailed The number of failed reads for all Configs.

EV GetWaferNumPassed The number of passed reads for all Configs.

EV GetWaferOrder The index of the Read Order setting.

EV SetWaferOrder

EV GetWaferScoreAs100 The scoring method for character positions fielded as dashes (-), dots (.) and spaces.
EV SetWaferScoreAs100

EV GetWaferSummary A summary of the results for the most recent read.

EV GetWaferTimeout The total amount of time (in seconds) to allow for a read.

EV SetWaferTimeout

For more information on these commands, refer to the In Sight® Guide & Reference
HTML Help file, included in the installation package.

7.1 Basic Native Mode Commands

The following Native Mode commands are used to remotely control a wafer reader from
user-designed software. Each command returns a Status Code, the number of characters
(in bytes, including Carriage Returns and Line Feeds) in the output that follows, and the
results.

7.1.1 Abort Execution

AE[2]

Terminates the current execution of the WaflD function within the spreadsheet. Unlike
most Native Mode commands, no status code is returned after the Abort Execution

command is executed, but depending on the function that is terminated, other information
may be returned.

Input: 2

Sample Input and Output

NOTE In this sample, Abort Execution causes the current read operation to terminate.

AE2

SM"READ"0
1

AE2
[UH5871X1CGC3,390.000,1.000]
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7.1.2 Send Message

SM"string"[Event]

Allows In-Sight protocol commands (see Section 3.6.2: Input/Output) to be sent over a
Native Mode connection to a wafer reader as a text string, and optionally, triggers a
spreadsheet Event.

Inputs: String, Event (Optional).

The Event codes are:

EVENT CODE DESCRIPTION
(0to7) Specifies a soft trigger (Soft 0, Soft 1, ... Soft 7).
8 Acquire an image and update the spreadsheet. This option requires the Acquirelmage
function’s Trigger argument to be External or Manual.

NOTE The string must be set off with quotations marks.

Output: Status Code, Read Result.

The status codes are:

STATUS CODE DESCRIPTION
1 The command was executed successfully.
0 Unrecognized command.
-2 The command could not be executed.

NOTE The outputs for the read result depend on which of the Output String, Output Score, and Output
Passed checkboxes are selected from the Options tab (see Section 3.6: Setting Options)

Sample Inputs and Outputs

SM"READ"0

1
[UH5871X1CGC3,398.000,1.000]

SM"TUNE(0)"0

1
[UH5871X1CGC3,391.000,1.000]
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7.1.3 Set Online
SO[inf]

Sets the In-Sight wafer reader into Online or Offline mode.

NOTE  This command cannot set the In-Sight wafer reader Online if it was previously set Offline manually
through the user interface, or by a discrete input signal.

Inputs: 0 to set In-Sight Offline, and 1 to set In-Sight Online.
Output: Status Code.

The status codes are:

STATUS CODE DESCRIPTION
1 The command was executed successfully.
0 Unrecognized command.
-1 The value given for intis either out of range, or is not a valid integer.
-5 The communications flag was successful but the wafer reader did not go Online because the
\gf?fer reader is set Offline manually through the user interface or the Discrete 1/0 setting is

Sample Input and Output

SO1

1
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7.2 Put Extended Native Mode Commands

The following commands are used in conjunction with the Put extended Native Mode
command to send information to the In-Sight spreadsheet and wafer reader. The
information sent is dependent on the command and input that is specified.

Syntax: Put [command]

7.2.1 Put Live
Put Live(<Input>)

Turns live acquisition on/off.

NOTES
m  The wafer reader must be Offline when using this command.

m  The live image will not be displayed in the GUI or PC Host.

Inputs: 0 to turn off live acquisition mode, and 1 to turn on live acquisition mode.
Output: Status Code, # of bytes

The status codes are:

STATUS CODE DESCRIPTION
1 The command was executed successfully.
0 Unrecognized command.
-1 The input is invalid.
-2 The command could not be executed, or the wafer reader is Online.

Sample Input and Output

NOTE In this sample, the first command puts the wafer reader into live acquisition mode, and the second
command takes the wafer reader out of live mode.

PUT LIVE 1

1

PUT LIVE 0

1
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7.2.2 Put PortNum
Put PortNum(<Input>)

Specifies the port that will be used by the In-Sight wafer reader for transferring data or
images over the network.

NOTES
m The wafer reader must be Offline when using the Portnum command.

m  The PortNum command must be executed before another device can connect to the specified port.

Inputs: 0 to 65535 to specify the port number.

NOTE A valid Port assignment is any unused number between 0 and 65535, excluding 21, 23, 68, 80,
502, 1069, 1070, 1212, 2222, 44818 and 50000 (reserved for In-Sight communications).

Output: Status Code

The status codes are:

STATUS CODE DESCRIPTION
1 The command was executed successfully.
0 Unrecognized command.
-1 The port number is invalid.
-2 The command could not be executed, the wafer reader is Online, or the specified port is
already in use.

Sample Input and Output

PUT PORTNUM 3001

1
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7.2.3 Put Watch
Put Watch(<Column><Row><Input>)

Returns the data contained in the specified cell each time the cell is updated.

NOTE The PortNum command must be executed to specify a port where the information will be sent by
the Watch command.

Inputs: Column, Row, Input

Output: Status Code

The status codes are:

STATUS CODE DESCRIPTION
1 The command was executed successfully.
0 Unrecognized command.
-2 The command could not be executed.

Sample Input and Output

PUT WATCH A000 1

1
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7.3 Evaluate Extended Native Mode Command
Inputs and Outputs

The table below lists the possible values of the settings that can be input and possible
values of the settings and results data returned by the Evaluate Extended Native Mode
commands. These output values are enclosed in Extensible Markup Language (XML)
tags. XML is a web document authoring language that allows users to create their own
customized tags. For more information on the XML format, go to:

www.w3.org/XML.

SETTING DESCRIPTION
<Accept> The minimum response threshold for the raw reading score.
40 - 100 (default = 50)
<AcqEnable> The status of the Disable Acquire setting.
0 = Disable
1=Enable
<AcquireFlag> Determines whether an image will be acquired when a read is performed.

0 = A read will be performed on the last image acquired.
1= A read will be performed after a new image is acquired.

<AvgScore> The average raw response score of all reads that passed for a Config.
0-100

<BC3Digits> The status of the Three Digits setting, when ‘BC, BC 412’ or ‘BC, IBM 412’ is the selected
Mark.

0 = Disable

1=Enable

<BCHyphen> The status of the Hyphen setting, when ‘BC, BC 412’ or ‘BC, IBM 412’ is the selected
Mark.

0 = Disable

1=Enable

<BComp> When ‘BC, BC 412’ or ‘BC, IBM 412’ is the selected Mark, an internally generated value is
returned for the encoded state of the settings, from the Advanced dialog, for the barcode
Compression option, Hyphen option and Three Digit option. For more information, see
section 3.5.4: Mark.

The values for the individual Advanced Dialog settings can be returned or set using:

EV GetConfigBCType
EV GetConfigBCHyphen
EV GetConfigBC3Digits

EV SetConfigBCType
EV SetConfigBCHyphen
EV SetConfigBC3Digits

<BCType> The index of the Compressed Barcode type for the specified Config, when ‘BC, BC 412’ or
‘BC, IBM 412’ is the selected Mark.
0 =None

1=Base 35

2 = Compressed 1

3 = Compressed 2

4 = Compressed 3

5= Compressed 4

6 = Compressed 5

7 = Compressed 6

8 = Compressed 7

9 = Compressed 8

<BestConfig> The index of the Config which returns the highest score.
0-9
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SETTING

DESCRIPTION

<Bright>

Determines whether Bright Field Light Mode settings will be tried during tuning.
0 = Disable Bright Field tuning
1 = Enable Bright Field tuning (default)

<Char>

The ASCII value of the specified character in a read string.

<Char Index>

Specifies the position number (zero-based) of a character within a string.

<CharSize>

The settings information for the Size setting.
High: 16 — 120 (default = 42)
Wide: 8 — 480 (default = 20)

<CharSpacing>

The setting for the tolerance of the spacing between adjacent characters and the vertical
alignment of the characters.

1 = Standard

2 =Relaxed

<CheckSum>

The method by which the read result from a character string will be validated to ensure
reliability, and establishes the scoring basis for determining the pass/fail status of the
read.

0 = Virtual

1=SEMI

2 = SEMI with Virtual (default)

3 =BC 412 with Virtual

4 = |BM 412 with Virtual

<Col>

The column coordinate of the input region or the individual character in a string.
640 x 480 image resolution: 0 — 639
1024 x 768 image resolution: 0 — 1023

<Color>

The expected color of the mark to read.
0 = Black
1= White

<Config>

The Config number (0-9).

<Dark>

Determines whether Dark Field Light Mode settings will be tried during tuning when using
the TuneConfig command.

0 = Disable Dark Field tuning

1 = Enable Dark Field tuning (default)

<Enable>

The status of the Enabled setting for the specified Config.
0 = Disable
1=Enable

<"FieldDef>

Specifies user-defined entries for the Field String.
User-defined

<"FieldString">

The number of characters contained in the character string or encoded in a barcode.
Alphanumerics (A-Z, 0-9), dashes (-), dots (.), spaces and entries from FieldDef.

<Fixture>

The coordinates and orientation of the fixture.
Col: 4t0 640

Row: 4 to 480

Theta: -179 to 180

<Flag>

Specifies whether tuning will be performed on a Config when using the TuneConfig or
TuneConfigEx extended native mode commands.

0 = Start tuning
1 = Continue tuning
2 = Accept current parameters

<High> (CharSize)

The height of a 2D symbol or the average height of the characters in a string, as
measured in pixels.
16 - 120 (default = 42)

<High> (Region)

The height of the region (along the Y-axis) in which the wafer mark is expected to appear
in the field of view.
4 — 240 (default = 100)

<Light>

Specifies whether lighting Mode and Power settings will be tried during the tuning process.
0 = Disable Light tuning
1 = Enable Light tuning (default)
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SETTING

DESCRIPTION

<LightMode>

Determines either a Bright Field or a Dark Field illumination effect on the mark.
0 = All lights are disabled

1 -3 = The mark will appear dark on a light background

4 - 11 = The mark will appear light on a dark background

<LightPower>

The exposure time of the wafer reader's CCD imager, in milliseconds.
0.000-33.000 (default = 2.000)

<Mark>

The type of wafer mark the selected Config will read.
0 =2D Sym, T7 Data Matrix

1=BC,BC 412

2=BC, IBM 412

3 = Internal Use Only

4 = Chars, SEMI

5= Chars, IBM

6 = Chars, Triple

<MarkColor>

Specifies whether Color settings will be tried during the tuning process.
0 = Disable Color tuning
1 = Enable Color tuning (default)

<NumFailed>

The number of failed reads for a Config.
0-99,999

<NumPassed>

The number of passed reads for a Config.
0-99,999

<NumTuneFailed>

The number of failed reads during a tune for a Config.
0-99,999

<NumTunePassed>

The number of passed reads during a tune for a Config.
0-99,999

<Optimization>

The index of the Optimization type for the specified Config, when ‘Chars, SEMI' is the
selected Mark.

0 = Speed (default)

1 = Reliability

<Order>

The order in which enabled Configs will be tried until a successful read can be obtained.
0 = Last Best (default)
1=In Order (0-9)

<QOrientation>

The index of the Img Orientation setting for the specified Config.
0 = Normal (default)

1 = Mirrored horizontally

2 = Flipped vertically

3 =Rotated 180 degrees

<Passed>

The pass/fail status of the specified Config for the most recent read.
0-99,999

<Phi> (Region)

The curve of the Config's region.
-360 to 360

<ReadLog>

A record of the most recent read that passed.
0-9

<Region>

The region where the wafer mark is expected to appear in the field of view.
Row:

640 x 480 image resolution: 0 — 479

1024 x 768 image resolution: 0 - 767

High:

640 x 480 image resolution: 4 — 240 (default = 100)
1024 x 768 image resolution: 4 — 240 (default = 100)
Col:

640 x 480 image resolution: 0 — 639

1024 x 768 image resolution: 0 - 1023

Wide:

640 x 480 image resolution: 4 — 640 (default = 500)
1024 x 768 image resolution: 4 — 1024 (default = 600)
Theta: -179 to 180

Phi: -360 to 360
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SETTING DESCRIPTION
<Retry> The tuning behavior.
0 = Disable (default)
1=Enable
2 = Enable & Apply
<Row> The row coordinate of the input region or the individual character in a string.
640 x 480 image resolution: 0 — 479
1024 x 768 image resolution: 0 — 767
<Score> The average raw response scores for all Configs that passed.
0-400
<ScoreAs100> The state of the optional scoring setting for character positions fielded as dashes (-), dots
(.) and spaces. This setting is only available for ‘Chars, SEMI’, ‘Chars, IBM’" and ‘Chars,
Triple’ Marks.
0 = Each character receives a weighted score based on the quality of the read.
1 = Each character automatically scores 100 points.
<Size> Specifies whether the mark size will be modified during tuning when using the TuneConfig
or TuneCofigEx extended native mode commands.
0 = Disable Size tuning
1 = Enable Size tuning (default)
<State> The scoring method for character positions fielded as dashes (-), dots (.) and spaces. This
setting is only available for ‘Chars, SEMI’, ‘Chars, IBM’ and ‘Chars, Triple’ Marks.
0 = Each character receives a weighted score based on the quality of the read.
1 = Each character automatically scores 100 points.
NOTE When the GetWaferAllEx command is issued, the <ScoreAs100> output
returns the <State> value.
<String> The character results from the read.
alphanumerics (A-Z, 0-9), dashes (-), dots (.), and spaces
<StringLen> The number of characters in the result string.
0-31
<Theta> (CharSize) The orientation of a 2D symbol or of the characters in a string, as measured in pixels.
<Theta> (Fixture) The orientation of the fixture.
0-359
<Theta> (Region) The angle of the Config's region.
-179 to 180
<Thresh> The character threshold setting.
25 to 100 (default = 25)
<Timeout> The total amount of time (in seconds) to allow for a read, including retries and tuning of
enabled Configs.
0-60 (default = 30)
<TryLog> The Retry status of the Config during the last read.
0-99,999
<TunelLog> The Retry and Tune status of the Config during the last read.
0-99,999
<Value> The raw response score of the specified character in a read string.
0-99,999
<WaflD> References the {31 W\ af1D) data structure in spreadsheet cell Ad.
<Wide> (CharSize) The width of a 2D symbol or the average width of the characters in a string, as measured
in pixels.
8 — 480 (default = 20)
<Wide> (Region) The width of the region (along the X-axis) where the wafer mark is expected to appear in
the field of view.
640 x 480 image resolution: 4 — 640 (default = 500)
1024 x 768 image resolution: 4 — 1024 (default = 600)
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7.4 Evaluate Extended Native Mode Commands
(Actions)

The following commands are used in conjunction with the Evaluate (EV) extended Native
Mode command to remotely control a wafer reader from user-designed software. Each
command returns a Status Code, the number of characters (in bytes, including Carriage
Returns and Line Feeds) in the output that follows, and the results in XML format.

Syntax: EV [command]

The status codes for all Evaluate commands are:

STATUS CODE DESCRIPTION
1 The command was executed successfully.
0 Unrecognized command.
-2 The command could not be executed.

7.4.1 EV AcquireConfig
EV AcquireConfig(<WaflD>,<Config>)

Acquires an image using the light settings in the specified Config. This command does
not read.

Inputs: WaflD, Config

Output: Status Code, # of bytes

Sample Input and Output

EV ACQUIRECONFIG(A4,0)

1
0

7.4.2 EV CopyConfig

EV CopyConfig(<WaflD>,<TargetConfig>,<SourceConfig>)

Copies all settings and read results from the source Config to the target Config.
Inputs: WaflD, TargetConfig, SourceConfig

Output: Status Code, # of bytes

Sample Input and Output

EV COPYCONFIG(A4,0,1)

1
0
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7.4.3 EV ReadConfig
EV ReadConfig(<WaflD>,<Config>,<AcquireFlag>)

Reads using the specified Config.

NOTE To execute a read of all enabled Configs, send the READ command, setting the <Config> input to
ll_1 Il.

Inputs: WaflD, Config, AcquireFlag
Outputs: Status Code, # of bytes, Passed, String, Score, TryLog, TunelLog, LastRead,

NumPassed, NumFailed, NumTunePassed, NumTuneFailed, AvgScore, High, Wide,
Theta, Char, Value (Orc), Row (Orc), Col (Orc)

Sample Input and Output

EV READCONFIG(A4,0,0)

1
1702
<Result 1d="0">
<Passed>1</Passed>
<String>6713H129S6Al</String>
<Score>395</Score>
<TryLog>0</TryLog>
<TuneLog>0</TuneLog>
<LastRead>10</LastRead>
<NumPassed>10</NumPassed>
<NumFailed>0</NumFailed>
<NumTunedPassed>0</NumTunedPassed>
<NumTuneFailed>0</NumTuneFailed>
<AvgScore>95</AvgScore>
<High>39</High>
<wWide>20</wide>
<Theta>0</Theta>
<0Orc 1d="0">
<Char>54</Char>
<value>98</value>
<Row>52</Row>
<Col>63</Col>
</0orc>
<Orc I1d="1">
<Char>55</Char>
<value>97</value>
<Row>51</Row>
<Co1>99</Col>
</0orc>
<0rc 1d="2">
<Char>49</Char>
<value>98</value>
<Row>50</Row>
<Col1>133</Col>
</0orc>
<0Orc 1d="3">
<Char>51</Char>
<value>95</value>
<Row>52</Row>
<Col1>168</Col>
</0orc>
<0rc 1d="4">
<Char>72</Char>
<value>99</value>
<Row>51</Row>
<Co1>204</Col>
</0orc>
<0Orc 1d="5">
<Char>49</Char>
<value>99</value>
<Row>51</Row>
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EV READCONFIG(A4,0,0)

<Co1>240</Col>

</0rc>

<Orc I1d="6">
<Char>50</Char>
<value>91</value>
<Row>52</Row>
<Col>274</Col>

</0rc>

<Orc 1d="7">
<Char>57</Char>
<value>93</value>
<Row>51</Row>
<Co1>310</Col>

</0rc>

<Orc 1d="8">
<Char>83</Char>
<value>92</value>
<Row>53</Row>
<Col1>344</Col>

</0rc>

<Orc 1d="9">
<Char>54</Char>
<value>96</value>
<Row>51</Row>
<Co1>381</Col>

</0rc>

<Orc I1d="10">
<Char>65</Char>
<value>93</value>
<Row>53</Row>
<Col1>415</Col>

</0rc>

<Orc Id="11">
<Char>49</cChar>
<value>96</value>
<Row>52</Row>
<Col1>452</Col>

</0rc>

</Result>

Other EV ReadConfig Commands

EV GetConfigOrcChar(<WaflD>,<Config>,<Char Index>)
EV GetConfigOrcRow(<WaflD>,<Config>,<Char Index>)
EV GetConfigOrcCol(<WaflD>,<Config>,<Char Index>)
EV GetConfigOrcVal(<WaflD>,<Config>,<Char Index>)
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7.4.4 EV TuneConfig
EV TuneConfig(<WaflD>,<Config>,<Flag>,<Bright>,<Dark>,<Size>)

Tunes the specified Config.

NOTE This command does not do an exhaustive tune; it only does one iteration of settings. The
command may need to be sent multiple times to obtain optimized settings.

Inputs: WaflD, Config, Flag, Bright, Dark, Size

Outputs: Status Code, # of bytes, NumRead, Passed (Current), String (Current), Score
(Current), Passed (Best), String (Best), Score (Best)

Sample Input and Output

EV TUNECONFIG(A4,0,1,1,1,1)

1
282
<TuneStep Id="0" Percent="1">
<NumRead>1</NumRead>
<Current>
<Passed>1</Passed>
<String>6713H129S6Al</String>
<Score>396</Score>
</Current>
<Best>
<Passed>1</Passed>
<String>6713H129S6Al</String>
<Score>396</Score>
</Best>
</TuneStep>

Example:
1 Toinitiate tuning, send the TuneConfig command, setting the <Flag> input to "0".
2 To continue tuning, send the TuneConfig command, setting the <Flag> input to "1".

3 Reissue the TuneConfig command with the <Flag> input to set to "1" until an
acceptable passing score is reached.

4 To accept the optimized settings when tuning is completed, resend the TuneConfig
command a final time, setting the <Flag> input to "2".
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7.4.5 EV TuneConfigEx
EV TuneConfigEx(<WaflD>,<Config>,<Flag>,<MarkColor>,<Light>,<Size>)

Tunes the specified Config.

NOTES
m [f Mark Color tuning is enabled and Light and Size tuning are disabled, tuning does not occur and the
Percent output is equal to "100" the first time the TuneConfigEx command is issued.

m  The TuneConfigEx command is only supported on In-Sight 1721/1722 wafer readers with firmware
version 3.20.05 and higher.

m This command does not do an exhaustive tune; it only does one iteration of settings. The command
may need to be sent multiple times to obtain optimized settings.

Inputs: WaflD, Config, Flag, MarkColor, Light, Size

Outputs: Status Code, # of bytes, NumRead, Passed (Current), String (Current), Score
(Current), Passed (Best), String (Best), Score (Best)

Sample Input and Output

EV TUNECONFIGEX(A4,0,1,1,1,1)

1
282
<TuneStep Id="0" Percent="1">
<NumRead>1</NumRead>
<Current>
<Passed>1</Passed>
<String>6713H129S6Al</String>
<Score>396</Score>
</Current>
<Best>
<Passed>1</Passed>
<String>6713H129S6Al</String>
<Score>396</Score>
</Best>
</TuneStep>

Example:
1 Toinitiate tuning, send the TuneConfigEx command, setting the <Flag> input to "0".

2 To continue tuning, send the TuneConfigEx command, setting the <Flag> input to
ll1 ll.

3 Reissue the TuneConfigex command with the <Flag> input to set to "1" until an
acceptable passing score is reached.

4 To accept the optimized settings when tuning is completed, resend the TuneConfigEx
command a final time, setting the <Flag> input to "2".
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7.4.6 EV ResetStats

EV ResetStats(<WaflD>)

Reset all accumulated read statistics.
Inputs: WaflD

Outputs: Status Code, # of bytes

EV RESETSTATS(A4)

1
0

7.5 Evaluate Extended Native Mode Commands
(Get)

The following commands are used in conjunction with the Evaluate (EV) extended Native
Mode command to retrieve settings and read results from the Configs in a wafer ID job.
Each command returns a Status Code, the number of characters (in bytes, including
Carriage Returns and Line Feeds) in the output that follows, and the results in XML
format.

Syntax: EV [command]

The status codes for all Evaluate commands are:

STATUS CODE DESCRIPTION
1 The command was executed successfully.
0 Unrecognized command.
-2 The command could not be executed.

7.5.1 EV GetConfig

EV GetConfig(<WaflD>,<Config>)

Returns the current settings for a Config.

Inputs: WaflD, Config

Outputs: Status Code, # of bytes, Mark, Checksum, LightMode, LightPower, Orientation,
Row (Region), Column (Region), High (Region), Wide (Region), Theta (Region), Phi

(Region), High (CharSize), Wide (CharSize), CharSpacing, FieldString, FieldDef, Color,
Accept, Enable, Retry, BComp, Thresh, Optimization
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Sample Input and Output

EV GETCONFIG(A4,0)

1
470
<Config 1d="0">
<Mark>4</Mark>
<Checksum>2</Checksum>
<LightMode>1</LightMode>
<LightPower>2</LightPower>
<Orientation>0</Orientation>
<Region>
<Row>280</Row>
<Col1>45</Col>
<High>100</High>
<Wide>500</wide>
<Theta>0</Theta>
<Phi>0</Phi>
</Region>
<Charsize>
<High>42</High>
<wide>22</wide>
</Charsize>
<Charspacing>1l</CharSpacing>
<FieldString>*¥¥*¥*¥*¥*¥****CS</FieldString>
<FieldDef></FieldDef>
<Color>2</Color>
<Accept>50</Accept>
<Enable>1</Enable>
<Retry>0</Retry>
<BComp>0</BComp>
<Thresh>25</Thresh>
<Optimization>0<Optimization>
</Config>

Other EV GetConfig Commands

EV GetConfigMark(<WaflD>,<Config>)

EV GetConfigChecksum(<WaflD>,<Config>)
EV GetConfigLightMode(<WaflD>,<Config>)
EV GetConfigLightPower(<WaflD>,<Config>)
EV GetConfigOrientation(<WaflD>,<Config>)
EV GetConfigRegionRow(<WaflD>,<Config>)
EV GetConfigRegionCol(<WaflD>,<Config>)
EV GetConfigRegionHigh(<WaflD>,<Config>)
EV GetConfigRegionWide(<WaflD>,<Config>)
EV GetConfigRegionTheta(<WaflD>,<Config>)
EV GetConfigRegionPhi(<WaflD>,<Config>)
EV GetConfigCharHigh(<WaflD>,<Config>)
EV GetConfigCharWide(<WaflD>,<Config>)
EV GetConfigFieldStr(<WaflD>,<Config>)

EV GetConfigFieldDef(<WaflD>,<Config>)

EV GetConfigColor(<WaflD>,<Config>)

EV GetConfigAccept(<WaflD>,<Config>)

EV GetConfigEnable(<WaflD>,<Config>)
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EV GetConfigRetry(<WaflD>,<Config>)

EV GetConfigBComp(<WaflD>,<Config>)

EV GetConfigThresh(<WaflD>,<Config>)

EV GetConfigOptimization(<WaflD>,<Config>)

7.5.2 EV GetConfigResult

EV GetConfigResult(<WaflD>,<Config>)

Returns the results of the most recent read performed by the specified Config.

Inputs: WaflD, Config

Outputs: Status Code, # of bytes, Passed, String, Score, TryLog, TunelLog, LastRead,

NumPassed, NumFailed, NumTunePassed, NumTuneFailed, AvgScore, High, Wide,
Theta, Char (Orc), Value (Orc), Row (Orc), Col (Orc)

Sample Input and Output

EV GETCONFIGRESULT(A4,0)

1
1701
<Result I1Id="0">
<Passed>1</Passed>
<String>6713H129S6Al</String>
<Score>396</Score>
<TryLog>1</TryLog>
<TuneLog>0</TuneLog>
<LastRead>10</LastRead>
<NumPassed>4</NumPassed>
<NumFailed>0</NumFailed>
<NumTunePassed>0</NumTunePassed>
<NumTuneFailed>0</NumTuneFailed>
<Avgscore>96</AvgScore>
<High>40</High>
<Wide>21</wide>
<Theta>0</Theta>
<0orc I1d="0">
<Char>54</cChar>
<value>96</value>
<Row>51</Row>
<Col1>25</Ccol>
</0orc>
<0orc Id="1">
<Char>55</Char>
<value>96</value>
<Row>51</Row>
<Col>65</Col>
</0orc>
<0orc Id="2">
<Char>49</cChar>
<value>98</value>
<Row>52</Row>
<Col1>105</Col>
</0orc>
<0orc I1d="3">
<Char>51</Char>
<value>97</value>
<Row>53</Row>
<Col1>145</Col>
</0orc>
<0orc I1d="4">
<Char>72</Char>
<value>99</value>
<Row>53</Row>
<Col1>187</Col>
</0orc>
<0orc Id="5">
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EV GETCONFIGRESULT(A4,0)

<Char>49</char>
<value>99</value>
<Row>54</Row>
<Co1>228</Col>

</0rc>

<Orc I1d="6">
<Char>50</Char>
<value>94</value>
<Row>54</Row>
<Co1>269</Col>

</0rc>

<Orc 1d="7">
<Char>57</Char>
<value>98</value>
<Row>55</Row>
<Co1>309</Col>

</0rc>

<Orc 1d="8">
<Char>83</Char>
<value>88</value>
<Row>56</Row>
<Co1>350</Col>

</0rc>

<Orc 1d="9">
<Char>54</Char>
<value>98</value>
<Row>56</Row>
<Col1>391</Col>

</0rc>

<Orc I1d="10">
<Char>65</Char>
<value>93</value>
<Row>58</Row>
<Col1>431</Col>

</0rc>

<Orc Id="11">
<Char>49</cChar>
<value>98</value>
<Row>57</Row>
<Col1>471</Col>

</0rc>

</Result>

Other EV GetConfigResult Commands

EV GetConfigPassed(<WaflD>,<Config>)

EV GetConfigString(<WaflD>,<Config>)

EV GetConfigScore(<WaflD>,<Config>)

EV GetConfigTryLog(<WaflD>,<Config>)

EV GetConfigTuneLog(<WaflD>,<Config>)

EV GetConfigLastRead(<WaflD>,<Config>)

EV GetConfigNumPassed(<WaflD>,<Config>)

EV GetConfigNumFailed(<WaflD>,<Config>)

EV GetConfigNumTunePassed(<WaflD>,<Config>)
EV GetConfigNumTuneFailed(<WaflD>,<Config>)
EV GetConfigAvgScore(<WaflD>,<Config>)

EV GetConfigHigh(<WaflD>,<Config>)

EV GetConfigWide(<WaflD>,<Config>)

EV GetConfigTheta(<WaflD>,<Config>)
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7.5.3 EV GetMSBuffer
EV GetMSBuffer (<Index>)

Returns the Machine Status data stored in one of 8 indexed buffers within the
MachineStatus stack. If the index is 0, the current Machine Status is returned.

Input: Index
Output: MachineStatus, TimeAndDate, HostName, InSightModel, FirmwareVersion,

BootTime, ActiveJob, JobLoadTime, Online, OperationalStatus, UserName,
UserHostName, UserData.

Sample Input and Output

EV GETMSBUFFER(0)

1

540

<MachineStatus>
<TimeAndDate>>08/15/2002 13:06:02</TimeAndDate>
<HostName>MyHost</HostName>
<InSightMode1>1000</InSightModel>
<Firmwareversion>2.40.01</Firmwareversion>
<BootTime>08/15/2002 11:00:05</BootTime>
<ActiveJob>FTP://SYSTEM1/MyJob. job</Activelob>
<JobLoadTime>08/13/2002 13:00:00</JobLoadTime>
<onTine>0</0OnTine>
<OperationalSstatus>MAINTENANCE</Operationalstatus>
<UserName>admin</UserName>
<UserHostName>SYSTEM1</UserHostName>
<UserData>PASS,SCORE=95,X=242,Y=348</UserData>

</MachineStatus>

7.5.4 EV GetWaferAll

EV GetWaferAll(<WaflD>)

Returns all results for the most recent read, and settings for all Configs.
Inputs: WaflD

Outputs: Status Code, # of bytes, BestConfig, Timeout, Order, AcqEnable, NumPassed,
NumFailed, AvgScore Row (Fixture), Col (Fixture), Theta (Fixture), Mark, Checksum,
LightMode, LightPower, Orientation, Row (Region), Col (Region), High (Region), Wide
(Region), Theta (Region), Phi (Region), High (Char), Wide (Char), FieldString, FieldDef,
Color, Accept, Enable, Retry, BComp, Thresh, Optimization, Passed, String, Score,
TryLog, TunelLog, LastRead, NumPassed, NumFailed, NumTunePassed,
NumTuneFailed, AvgScore, High, Wide, Theta, Char (Orc) Value (Orc), Row, (Orc), Col
(Orc)
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Sample Input and Output

In-Sight® 1700 Series Wafer Reader

EV GETWAFERALL(A4)

1
23626
<wafer>
<BestcConfig>0</BestConfig>
<Timeout>30</Timeout>
<order>0</0Order>
<AcgEnable>1</AcqEnable>
<NumPassed>4</NumPassed>
<NumFailed>0</NumFailed>
<AvgScore>96</AvgScore>
<Fixture>
<Row>0</Row>
<Col>0</Col>
<Theta>0</Theta>
</Fixture>
<Config Id="0">
<Mark>4</Mark>
<Checksum>2</Checksum>
<LightMode>1</LightMode>
<LightPower>2</L1ghtPower>
<Orientation>0</Orientation>
<Region>
<Row>280</Row>
<Col1>45</Col>
<High>100</High>
<wide>500</Wide>
<Theta>0</Theta>
<Phi>0</Phi>
</Region>
<Charsize>
<High>42</High>
<wide>22</wide>
</Charsize>
<FieldString>#*¥***¥*****Cs</FieldString>
<Fieldpef></FieldDef>
<Color>2</Color>
<Accept>50</Accept>
<Enable>1</Enable>
<Retry>0</Retry>
<BComp>0</BComp>
<Thresh>25</Thresh>
<Optimization>0</0Optimization>
</Config>
<Result Id="0">
<Passed>1</Passed>
<String>6713H129S6Al</String>
<Score>396</Score>
<TryLog>1</TryLog>
<TuneLog>0</TuneLog>
<LastRead>10</LastRead>
<NumPassed>4</NumPassed>
<NumFailed>0</NumFailed>
<NumTunePassed>0</NumTunePassed>
<NumTuneFailed>0</NumTuneFailed>
<AvgScore>96</AvgScore>
<High>40</High>
<wide>21</Wide>
<Theta>0</Theta>
<0orc I1d="0">
<Char>54</Char>
<value>96</value>
<Row>51</Row>
<Col1>25</Col>
</0orc>
<0orc I1d="1">
<Char>55</Char>
<value>96</value>
<Row>51</Row>
<Col>65</Col>
</0rc>
<0orc I1d="2">
<Char>49</Char>
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EV GETWAFERALL(A4)

<value>98</value>
<Row>52</Row>
<Co1>105</Col>

</0orc>

<0rc 1d="3">
<Char>51</Char>
<value>97</value>
<Row>53</Row>
<Co1>145</Ccol>

</0orc>

<0Orc 1d="4">
<Char>72</Char>
<value>99</value>
<Row>53</Row>
<Co1>187</Col>

</0orc>

<0rc 1d="5">
<Char>49</Char>
<value>99</value>
<Row>54</Row>
<Co1>228</Col>

</0rc>

<0rc 1d="6">
<Char>50</Char>
<value>94</value>
<Row>54</Row>
<Co1>269</Col>

</0orc>

<0rc 1d="7">
<Char>57</Char>
<value>98</value>
<Row>55</Row>
<Co1>309</Ccol>

</0orc>

<0Orc 1d="8">
<Char>83</Char>
<value>88</value>
<Row>56</Row>
<Col1>350</Col>

</0orc>

<0rc 1d="9">
<Char>54</Char>
<value>98</value>
<Row>56</Row>
<Col1>391</Col>

</0orc>

<Orc I1d="10">
<Char>65</Char>
<value>93</value>
<Row>58</Row>
<Col1>431</Col>

</0orc>

<Orc Id="11">
<Char>49</Char>
<value>98</value>
<Row>57</Row>
<Col1>471</Col>

</orc>

</Result>
(<Config Id="1"> through <Config Id="9" omitted>)
</wafer>

Other EV GetWafer Commands

EV GetWaferTimeout(<WaflD>)
EV GetWaferOrder(<WaflD>)

EV GetWaferAcgEnable(<WaflD>)
EV GetWaferBestConfig(<WaflD>)
EV GetWaferFixRow(<WaflD>)
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EV GetWaferFixCol(<WaflD>)

EV GetWaferFixTheta(<WaflD>)
EV GetWaferNumPassed(<WaflD>)
EV GetWaferNumFailed(<WaflD>)
EV GetWaferAveScore(<WaflD>)
EV GetWaferString(<WaflD>)

7.5.5 EV GetWaferAllEx
EV GetWaferAllEx(<WaflD>)

Returns all results for the most recent read, and settings for all Configs.

NOTE The GetWaferAllEx command is only supported on In-Sight 1721/1722 wafer readers with firmware
version 3.20.05 and higher.

Inputs: WaflD

Outputs: Status Code, # of bytes, BestConfig, Timeout, Order, AcqEnable, NumPassed,
NumFailed, AvgScore, ScoreAs100, Row (Fixture), Col (Fixture), Theta (Fixture), Mark,
Checksum, LightMode, LightPower, Orientation, Row (Region), Col (Region), High
(Region), Wide (Region), Theta (Region), Phi (Region), High (Char), Wide (Char),
FieldString, FieldDef, Color, Accept, Enable, Retry, BComp, Thresh, Optimization,
Passed, String, Score, TryLog, TunelLog, LastRead, NumPassed, NumFailed,
NumTunePassed, NumTuneFailed, AvgScore, High, Wide, Theta, Char (Orc) Value
(Orc), Row, (Orc), Col (Orc)
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EV GETWAFERALLEX(A4)

1

23626

<wafer>
<BestcConfig>0</BestConfig>
<Timeout>30</Timeout>
<order>0</0Order>
<AcgEnable>1</AcqEnable>
<NumPassed>4</NumPassed>
<NumFailed>0</NumFailed>
<AvgScore>96</AvgScore>

<ScoreAs100>0</ScoreAs100>

<Fixture>
<Row>0</Row>
<Col>0</Col>
<Theta>0</Theta>
</Fixture>
<Config Id="0">
<Mark>4</Mark>
<Checksum>2</Checksum>
<LightMode>1</LightMode>
<LightPower>2</L1ghtPower>
<Orientation>0</Orientation>
<Region>
<Row>280</Row>
<Col1>45</Col>
<High>100</High>
<Wide>500</wide>
<Theta>0</Theta>
<Phi>0</Phi>
</Region>
<Charsize>
<High>42</High>
<wide>22</Wide>
</Charsize>
<FieldString>#¥#w¥
<Fieldpef></FieldDef>
<Color>2</Color>
<Accept>50</Accept>
<Enable>1</Enable>
<Retry>0</Retry>
<BComp>0</BComp>
<Thresh>25</Thresh>
<Optimization>0</0Optimization>
</Config>
<Result Id="0">
<Passed>1</Passed>
<String>6713H129S6Al</String>
<Score>396</Score>
<TryLog>1</TryLog>
<TuneLog>0</TuneLog>
<LastRead>10</LastRead>
<NumPassed>4</NumPassed>
<NumFailed>0</NumFailed>

<AvgScore>96</AvgScore>
<High>40</High>
<wide>21</wide>
<Theta>0</Theta>
<0orc I1d="0">
<Char>54</Char>
<value>96</value>
<Row>51</Row>
<Col1>25</Col>
</0orc>
<0orc Id="1">
<Char>55</Char>
<value>96</value>
<Row>51</Row>
<Col1>65</Col>
</0orc>

**CS</FieldSstring>

<NumTunePassed>0</NumTunePassed>
<NumTuneFailed>0</NumTuneFailed>
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In-Sight® 1700 Series Wafer Reader

EV GETWAFERALLEX(A4)

<0orc Id="2">
<Char>49</Char>
<value>98</value>
<Row>52</Row>
<Co1>105</Col>
</0orc>
<0orc Id="3">
<Char>51</Char>
<value>97</value>
<Row>53</Row>
<Co1>145</Col>
</0orc>
<0orc I1d="4">
<Char>72</Char>
<value>99</value>
<Row>53</Row>
<Co1>187</Col>
</0orc>
<0orc Id="5">
<Char>49</Char>
<value>99</value>
<Row>54</Row>
<Co1>228</Col>
</0rc>
<0orc Id="6">
<Char>50</Char>
<value>94</value>
<Row>54</Row>
<Co1>269</Col>
</0orc>
<0orc I1Id="7">
<Char>57</Char>
<value>98</value>
<Row>55</Row>
<Co1>309</Col>
</0orc>
<0orc I1d="8">
<Char>83</Char>
<value>88</value>
<Row>56</Row>
<Co1>350</Col>
</0orc>
<0orc I1Id="9">
<Char>54</Char>
<value>98</value>
<Row>56</Row>
<Co1>391</Col>
</0rc>
<orc Id="10">
<Char>65</Char>
<value>93</value>
<Row>58</Row>
<Col1>431</Col>
</0orc>
<orc Id="11">
<Char>49</Char>
<value>98</value>
<Row>57</Row>
<Col1>471</Col>
</0orc>
</Result>
. (<Config 1d="1"> through <Config Id="9" omitted>)
</wafer>
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7.5.6 EV GetWaferScoreAs100

EV GetWaferScoreAs100(<WaflD>)

Returns the state of the optional scoring setting for character positions fielded as dashes
(-), dots (.) and spaces. This setting is only available for ‘Chars, SEMI’, ‘Chars, IBM’ and
‘Chars, Triple’ Marks.

Inputs: WaflD

Outputs: Status Code, # of bytes, State

Sample Input and Output

EV GETWAFERSCOREAS100(A4)

1
18
<Float>0</Float>

7.5.7 EV GetWaferSummary
EV GetWaferSummary(<WaflD>)

Returns a summary of the results for the most recent read.

NOTE A ConfigLog will be returned for all Enabled Configs.

Inputs: WaflD

Outputs: Status Code, # of bytes, BestConfig, Passed, String, Score, Row (Region), Col
(Region), High (Region), Wide (Region), NumPassed, NumFailed, AvgScore, ReadLog,
Passed (ConfigLog), String (ConfigLog), Score (ConfigLog), TryLog (ConfigLog),
TuneLog (ConfigLog), NumPassed (ConfigLog), NumFailed (ConfigLog),
NumTunedPassed (ConfigLog), NumTuneFailed (ConfigLog), AvgScore (ConfigLog)
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Sample Input and Output

In-Sight® 1700 Series Wafer Reader

EV GETWAFERSUMMARY (A4)

1
832
<wafersummary>

<Row>0</Row>
<Co1>0</Col>
<Theta>0</Theta>

</Fixture>
<BestcConfig>0</BestConfig>
<Passed>1</Passed>

<Score>396</Score>
<Region>
<Row>280</Row>
<Col1>45</Col>
<High>100</High>
<Wide>500</wide>
</Region>
<NumPassed>4</NumPassed>
<NumFailed>0</NumFailed>
<AvgScore>96</AvgScore>
<ReadLog></ReadLog>
<ConfigLog Id="0">
<Passed>1</Passed>

<Score>396</Score>
<TryLog>1</TryLog>
<TuneLog>0</TuneLog>
<NumPassed>4</NumPassed>
<NumFailed>0</NumFailed>

<Av%$core>96</Angcore>
</ConfigLog>
</Wafersummary>

<String>6713H129S6Al</String>

<String>6713H129S6Al</String>

<NumTunedPassed>0</NumTunedPassed>
<NumTuneFailed>0</NumTuneFailed>
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7.6 Evaluate Extended Native Mode Commands
(Set)

The following commands are used in conjunction with the Evaluate (EV) extended Native
Mode command to change Config settings in a wafer ID job. Each command returns a
Status Code, and the number of characters (in bytes, including Carriage Returns and
Line Feeds) in the output that follows.

Syntax: EV [command]

The status codes for all Evaluate commands are:

STATUS CODE DESCRIPTION
1 The command was executed successfully.
0 Unrecognized command.
-2 The command could not be executed.

7.6.1 EV SetConfig

EVSetConfigAccept(<WaflD>,<Config>,<Mark>,<Checksum>,<LightMode>,
<LightPower>,<Orientation>,<Row>,<Col>,<High>,<Wide>,<Theta>,<Phi>,<High>,
<Wide>,<CharSpacing>,<"FieldString">,<"FieldDef">,<Color>,<Accept>,<Enable>,
<Retry>,<BComp>,<Thresh>)

Specifies all settings for the specified Config.

Inputs: WaflD, Config, Mark, Checksum, LightMode, LightPower, Orientation, Row, Col,
High, Wide, Theta, Phi, High, Wide, CharSpacing, FieldString, FieldDef, Color, Accept,
Enable, Retry, BComp, Thresh

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIG(A4,0,4,2,1,2,0,280,45,100,500,0,0,42,22,1,"*** %% *%%**cs" "™ 2,50,1,0,0,25)

1
0
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7.6.2 EV SetConfigAccept

EV SetConfigAccept(<WaflD>,<Config>,<Accept>)

Sets the minimum response threshold for the raw reading score of the specified Config.
Inputs: WaflD, Config, Accept

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGACCEPT(A4,0,50)

1
0

7.6.3 EV SetConfigBC3Digits
EV SetConfigBC3Digits(<WaflD>,<Config>,<BC3Digits>)

When ‘BC, BC 412’ or ‘BC, IBM 412’ is the selected Mark, SetConfigBC3Digits specifies
the status of the Three Digit setting for a compressed barcode.

Inputs: WaflD, Config, BC3Digits

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGBC3DIGITS(A4,0,0)

1
0
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7.6.4 EV SetConfigBCHyphen
EV SetConfigBCHyphen(<WaflD>,<Config>,<BCHyphen>)

When ‘BC, BC 412’ or ‘BC, IBM 412’ is the selected Mark, SetConfigBCHyphen specifies
the status of the Hyphen setting for a compressed barcode.

Inputs: WaflD, Config, BCHyphen

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGBCHYPHEN(A4,0,0)

1
0

7.6.5 EV SetConfigBCType
EV SetConfigBCType(<WaflD>,<Config>,<BCType>)

When ‘BC, BC 412’ or ‘BC, IBM 412’ is the selected Mark, SetConfigBCType specifies
the index of the compressed barcode type.

Inputs: WaflD, Config, BCType

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGBCTYPE(A4,0,0)

1
0

7.6.6 EV SetConfigCharSize

EV SetConfigCharSize(<WaflD>,<Config>,<High>,<Wide>)

Sets the expected size of an individual character or 2D mark for the specified Config.
Inputs: WaflD, Config, High, Wide

Outputs: Status Code, # of bytes
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Sample Input and Output

EV SETCONFIGCHARSIZE(A4,0,40,20)

1
0

7.6.7 EV SetConfigCharSpacing

EV SetConfigCharSpacing(<WaflD>,<Config>,<CharSpacing>)

When ‘Chars, SEMI’, ‘Chars, IBM’ or ‘Chars, Triple’ is the selected Mark, the Character
Spacing setting controls the tolerance of the spacing between adjacent characters and
the vertical alignment of the characters.

Inputs: WaflD, Config, CharSpacing

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGCHARSPACING(A4,0,0)

1
0

7.6.8 EV SetConfigChecksum

EV SetConfigChecksum(<WaflD>,<Config>,<Checksum>)

Selects the method by which the read result from a character string will be validated to
ensure reliability, and establishes the scoring basis for determining the pass/fail status of
the read.

Inputs: WaflD, Config, Checksum

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGCHECKSUM(A4,0,1)

1
0
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7.6.9 EV SetConfigColor

EV SetConfigColor(<WaflD>,<Config>,<Color>)
Sets the expected color of the wafer mark.

Inputs: WaflD, Config, Color

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGCOLOR(A4,0,1)

1
0

7.6.10 EV SetConfigEnable
EV SetConfigEnable(<WaflD>,<Config>,<Enable>)

Specifies whether a Config is enabled or disabled, which determines if the specified
Config will be used during the retry sequence at runtime.

Inputs: WaflD, Config, Enable

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGENABLE(A4,0,1)

1
0

7.6.11 EV SetConfigFieldDef
EV SetConfigFieldDef(<WaflD>,<Config>,<”FieldDef’>)

Defines the Field String when Mark specifies a character string or barcode.

NOTE The FieldDef input must be set off with quotation marks.

Inputs: WaflD, Config, FieldDef

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGFIELDDEF(A4,0,"A=A;B=B")

1
0
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7.6.12 EV SetConfigFieldString
EV SetConfigFieldString(<WaflD>,<Config>,<”FieldString”>)

Specifies the number of characters contained in the character string or encoded in a
barcode.

NOTE The FieldString input must be set off with quotation marks.

Inputs: WaflD, Config, FieldString

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGFIELDSTRING(A 4,0, "****xwxt)

1
0

7.6.13 EV SetConfigLightMode

EV SetConfigLightMode(<WaflD>,<Config>,<LightMode>)

Specifies either a Bright Field or a Dark Field illumination effect on the mark.
Inputs: WaflD, Config, LightMode

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGLIGHTMODE(A4,0,11)

1
0

7.6.14 EV SetConfigLightPower
EV SetConfigLightPower(<WaflD>,<Config>,<LightPower>)

Controls the effective intensity of the LEDs on the mark by increasing the exposure time
of the wafer reader’'s CCD imager.

Inputs: WaflD, Config, LightPower

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGLIGHTPOWER(A4,0,25.123)

1
0
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7.6.15 EV SetConfigMark

EV SetConfigMark(<WaflD>,<Config>,<Mark>)

Specifies the type of wafer mark the selected Config will read.
Inputs: WaflD, Config, Mark

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGMARK(A4,0,1)

1
0

7.6.16 EV SetConfigOptimization
EV SetConfigOptimization(<WaflD>,<Config>,<Optimization>)

When ‘Chars, SEMI’ is the selected Mark, SetConfigOptimization sets the Optimization
for the specified Config.

Inputs: WaflD, Config, Optimization

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGOPTIMIZATION(A4,0,1)

1
0

7.6.17 EV SetConfigOrientation

EV SetConfigOrientation(<WaflD>,<Config>,<Orientation>)
Sets the orientation of the image.

Inputs: WaflD, Config, Orientation

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGORIENTATION(A4,0,0)

1
0
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7.6.18 EV SetConfigRegion
EV SetConfigRegion(<WaflD>,<Config>,<Row>,<Col>,<High>,<Wide>)

Sets the region where the wafer mark is expected to appear in the field of view for the
specified Config.

Inputs: WaflD, Config, Row, Col, High, Wide
Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGREGION(A4,0,150,60,100,500)

1
0

7.6.19 EV SetConfigRetry

EV SetConfigRetry(<WaflD>,<Config>,<Retry>)

Specifies how the Config will be used during the retry sequence at runtime.
Inputs: WaflD, Config, Retry

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGRETRY(A4,0,1)

1
0

7.6.20 EV SetConfigThresh

EV SetConfigThresh(<WaflD>,<Config>,<Thresh>)

Specifies the minimum response threshold for each individual character score. Each
]icr;ﬁ?vidual character score must be greater than the Character Threshold or the read will
Inputs: WaflD, Config, Thresh

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETCONFIGTHRESH(A4,0,50)

1
0
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7.6.21 EV SetWaferAcqgEnable

EV SetWaferAcqEnable(<WaflD>,<AcqEnable>)

Disables image acquisition to allow a test read from the last image acquired, or from an
image file, when the wafer reader is Offline. The Light Mode and Light Power settings are
temporarily disabled.

Inputs: WaflD, AcqEnable

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETWAFERACQENABLE(A4,0)

1
0

7.6.22 EV SetWaferOrder

EV SetWaferOrder(<WafiD>,<Order>)

The order in which enabled Configs will be tried until a successful read can be obtained.
Inputs: WaflD, Order

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETWAFERORDER(A4,0)

1
0

7.6.23 EV SetWaferScoreAs100

EV SetWaferScoreAs100(<WaflD>, <State>)

Specifies whether character positions fielded as dashes (-), dots (.) and spaces
automatically score 100 points or receive a weighted score based on the quality of the
read. This setting is only available for ‘Chars, SEMI’, ‘Chars, IBM’ and ‘Chars, Triple’
Marks.

Inputs: WaflD, State

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETWAFERSCOREAS100(A4,1)

1
0
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7.6.24 EV SetWaferTimeout
EV SetWaferTimeout(<WaflD>,<Timeout>)

Specifies the total amount of time (in seconds) to allow for a read, including retries and
tuning of enabled Configs.

Inputs: WaflD, Timeout

Outputs: Status Code, # of bytes

Sample Input and Output

EV SETWAFERTIMEOUT(A4,45)

1
0
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Section 8: Specifications

In-Sight® 1700 Series Wafer Reader

8.1 General Specifications

Table 8-1: In-Sight 1721/1722 Wafer Reader General Specifications

Specification

Description

Configurations Vertical mount w/ factory-set 50.0mm working distance.
In-Sight 1721: P/N 800-5865-1; P/N 800-5865-1R (RoHS Compliant)
In-Sight 1722: P/N 800-5865-2; P/N 800-5865-2R (RoHS Compliant)
Optional Horizontal Mirror Mount (800-5796-1)

Firmware In-Sight version 2.90 and later.

Reading Capability Supported Wafer Marks Standards
SEMI font SEMIM12, M13, M1.15
OCR IBM font N/A
Triple font N/A
2D Data Matrix™ (ECC 200, 8 x 32) | SEMI T7 and M1.15
Barcode | BC 412 and IBM 412 SEMI T1-95
Memory Job/Program 32MB non-volatile flash memory; unlimited storage via remote network device.
Image/Processing | 32MB SDRAM
Image Sensor 1/3-inch CCD
Optical Properties | 6.0mm diagonal, 4.65 x 4.65um sq. pixels
Resolution 1024 x 768
glr:a:et(rjonlc Shutter 64ps to 33ms; up to 18 frames per second.
Acquisition Rapid reset, progressive scan (supports partial scan), full-frame integration.
256 gray levels (8 bits/pixel)
Gain controlled by software.
Lighting/Optics Working Distance: adjustable, w/ factory-set option of 50.0mm (Vertical).
Recommended working distance range: 1 to 80.0mm (Vertical); 1 to 56.0mm
(Horizontal).
[llumination Area: 31.0mm (W) x 19.0mm (H) (nominal; depends on lighting Mode).
In-Sight 1721: Red LEDs, 630nm wavelength, with the ability to read bright field and
dark field images. Variable exposure controlled through software. Maximum output
power <40 microwatts.
In-Sight 1722: Infrared LEDs, 880nm wavelength, with the ability to read bright field
and dark field images. Variable exposure controlled through software. Maximum output
power <60 microwatts.
110 Trigger 1 opto-isolated, acquisition trigger input.

Remote software commands via Ethernet and RS-232.

Discrete Inputs

None built-in.

Unlimited inputs when using an Ethernet 1/0 system.

Discrete Outputs | None built-in.
Unlimited outputs when using an Ethernet I/0 system.
Status LEDs 1 Network Traffic/Network Status, 2 User-Configurable, 1 Power
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Communications Network

1 Ethernet port, 10/100 Base-T, TCP/IP protocol. Supports DHCP (factory default) or
static IP address.

Serial 1 RS-232C port (4800 to 115,200 baud rates).
Protocols In-Sight, Native Mode, Electroglas and LKx5.
Power 24 £10% VDC; 140mA (illumination off) to 200mA (illumination on).
Mechanical Material Aluminum housing, black anodized with nickel-plated black end caps.
Mounting Eight 7.3mm deep M4 threaded mounting holes (four per side).
Maximum torque 1.5 N-m (13.5 in-Ib).
Dimensions 125.8mm (4.95in) x 70.4mm (2.77in) x 36.9mm (1.45in)
Horizontal configuration length: 151.2mm (5.95in)
Weight 379.99 (134 0z).

Environmental Temperature

0 to 45°C (Operating), -10 to 65°C (Storage).

Humidity

10 to 90%, non-condensing (Operating and Storage).

Certifications

CE, UL, CUL, FCC

IEC 60825-1/A2:2001, EN 60825-1/A1:2002, CAN/CSA-E60825-1:2003 Class 1 LED
Product

This equipment conforms with the applicable requirements of SEMI S2-0703a

COGNEX
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In-Sight® 1700 Series Wafer Reader

Table 8-2: In-Sight 1701 Wafer Reader General Specifications

SPECIFICATION DESCRIPTION
Configurations o Vertical Mount w/ factory-set 10mm Working Distance (P/N 800-5797-1)
o Vertical Mount w/ factory-set 50mm Working Distance (P/N 800-5798-1)
o Optional Horizontal Mirror Mount (800-5796-1)
Firmware In-Sight version 2.40 - In-Sight version 2.70
Reading Capability Supported Wafer Marks Standards
SEMI font SEMIM12, M13, M1.15
OCR IBM font N/A
Triple font N/A
2D Data Matrix™ (ECC 200, 8 x 32) | SEMI T7 and M1.15
Barcode BC 412 and IBM 412 SEMI T1-95
Memory Job/Program 8MB non-volatile flash memory; Unlimited storage via remote network device
Image/Processing | 16MB SDRAM
Image Sensor 1/3-inch CCD
Optical Properties | 6mm diagonal, 4.65 x 4.65um sq. pixels
Resolution (pixels) | 1024 x 768
Electronic Shutter .
Speed 64ps to 33ms; Up to 18 frames per second
Acquisition Rapid reset, progressive scan (supports partial scan), full-frame integration
256 gray levels (8 bits/pixel)
Gain controlled by software
Lighting/Optics Working Distance: adjustable, w/ factory-set options of 10 or 50mm (Vertical).
Recommended working distance range: 1 to 80mm (Vertical); 1 to 56.1mm (Horizontal)
lllumination Area: 31mm (W) x 19mm (H) (Nominal; depends on Light Mode)
Red LEDs, 626nm wavelength, w/ Bright Field and Dark Field modes
Variable intensity controlled through software
I[0] Trigger 1 opto-isolated, acquisition trigger input
Remote software commands via Ethernet and RS-232
Discrete Inputs None built-in
Unlimited inputs when using an Ethernet 1/O system.
Discrete Outputs | None built-in

Unlimited outputs when using an Ethernet I/O system.

Status LEDs 1 Network Traffic, 1 Network Status, 1 Network Speed, 2 User-Configurable
Communications  Network 1 Ethernet port, 10/100 BaseT, TCP/IP protocol. Supports DHCP (factory default) or
static IP address.
Serial 1 RS-232C port (1200 to 115,200 baud rates)
Protocols In-Sight, Native Mode and Electroglas
Power 24 £10% VDC; 125mA (illumination off) to 200mA (illumination on)
Mechanical Material Aluminum housing, black anodized
Mounting Four 6.5mm deep M4 threaded mounting holes (two per side)
Maximum torque 1.5 N-m (13.5 in-Ib)
Dimensions 115.6mm (4.55in) x 69.9mm (2.75in) x 54.9mm (2.16in)
Horizontal configuration length: 141.0mm (5.55in)
Weight 416.7 g (14.7 0z)
Environmental Temperature 10 to 45°C (Operating), -10 to 65°C (Storage)
Humidity 10 to 90%, non-condensing (Operating and Storage)
Certifications CE, UL, CUL, FCC
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Table 8-3: In-Sight 1700 Wafer Reader General Specifications

SPECIFICATION DESCRIPTION
Configurations o Vertical Mount (P/N 800-5748-10)
o Horizontal Mount (P/N 800-5748-20)
Firmware In-Sight version 2.13 - In-Sight version 2.70
Reading Capability Supported Wafer Marks Standards
SEMI font SEMIM12, M13, M1.15
OCR IBM font N/A
Triple font N/A
2D Data Matrix™ (ECC 200, 8 x 32) | SEMI T7 and M1.15
Barcode BC 412 and IBM 412 SEMI T1-95
Memory Job/Program 4MB non-volatile flash memory; Unlimited storage via remote network device
Image/Processing | 16MB SDRAM
Image Sensor 1/3-inch CCD
Optical Properties | 6mm diagonal, 7.4 x 7.4pm sq. pixels
Resolution (pixels) | 640 x 480
E::::zonic Shutter 64ps to 33ms; Up to 30 frames per second
Acquisition Rapid reset, progressive scan (supports partial scan), full-frame integration
256 gray levels (8 bits/pixel)
Gain controlled by software
Lighting/Optics Working Distance: 10mm (Vertical); 15mm (Horizontal)
Depth of focus: + 3mm
lllumination Area: 25mm (W) x 10mm (H) (Nominal; depends on Light Mode)
Red LEDs, 626nm wavelength, w/ Bright Field and Dark Field modes
Variable intensity controlled through software
1[0] Trigger 1 opto-isolated, acquisition trigger input
Remote software commands via Ethernet and RS-232
Discrete Inputs None built-in
Unlimited inputs when using an Ethernet I/O system.
Discrete Outputs | None built-in
Unlimited outputs when using an Ethernet 1/0 system.
Status LEDs 1 Network Traffic, 1 Network Status, 1 Network Speed, 2 User-Configurable
Communications  Network 1 Ethernet port, 10/100 BaseT, TCP/IP protocol. Supports DHCP (factory default) or
static IP address.
Serial 1 RS-232C port (1200 to 115,200 baud rates)
Protocols In-Sight, Native Mode and Electroglas
Power 24 +£10% VDC; 125mA (illumination off) to 200mA (illumination on)
Mechanical Material Aluminum housing, black anodized
Mounting Four 6.5mm deep M4 threaded mounting holes (two per side)
Maximum torque 1.5 N-m (13.5 in-Ib)
Dimensions 116.7mm (4.55in) x 69.9mm (2.75in) x 54.9mm (2.16in)
Weight 416.7 g (14.7 0z)
Environmental Temperature 10 to 45°C (Operating), -10 to 65°C (Storage)
Humidity 10 to 90%, non-condensing (Operating and Storage)
Certifications CE, UL, CUL, FCC
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In-Sight® 1700 Series Wafer Reader

8.2 1/0 Specifications

The In-Sight wafer reader features one built-in acquisition trigger input and two user-
configurable LED outputs for general-purpose use.

8.2.1 Breakout Port Pin Assignments

Table 8-4 lists the pin assignment for each of the 8 signal lines of the Breakout Port
(labeled “24VDC”) according to each method of access.

Table 8-4: Breakout Port Pin Assignments

IN-SIGHT BREAKOUT SIGNAL BREAKOUT CABLE BREAKOUT MODULE*
PORT PIN WIRE COLOR TERMINALS
1 +24VDC White/Green 6, 8,10, 12, 14, 15, 16 (+24V)
2 Trigger + Green 5 (TRG+)
3 Trigger - White/Orange 4 (TRG-)
4 cTS Blue RS-232 serial (9-pin DSUB
connector)
5 RTS White/Blue RS-232 serial (9-pin DSUB
connector)
6 Serial Receive Orange RS-232 serial (9-pin DSUB
connector)
7 Serial Transmit White/Brown RS-232 serial (9-pin DSUB
connector)
8 Ground Brown 1,2, 3 (GND)

* Refer to the In-Sight Breakout Module Installation and Reference (P/N 597-0008-xx) for more detailed information.

NOTE Unused bare wires can be clipped short or tied back using a tie made from non-conductive
material. Keep all bare wires separated from the +24VDC (White/Green) wire.
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8.2.2 Acquisition Trigger Input
In-Sight 1721/1722 Acquisition Trigger Input Specifications

Table 8-5: Acquisition Trigger Input Specifications

SPECIFICATION DESCRIPTION
VOLTAGE ON 20 to 28V (24V nominal)
OFF 0 to 3V (12V nominal threshold)
CURRENT ON 2.0 to 2.9mA
OFF <150pA

Resistance ~10,000 Ohms

For higher current add external resistor (for example, 2.2kQ, 0.5W for 12mA) across inputs.

DELAY In-Sight 1721/ 76 uSec latency between leading edge of trigger and start of acquisition. Input pulse should
In-Sight 1722 be minimum of 1ms wide.

The acquisition trigger input is opto-isolated. To trigger from an NPN (pull-down) type
photo-detector or PLC output, connect pin 2 (TRG+) to +24V and connect pin 3 (TRG-) to
the output of the detector. When the output turns ON, it pulls TRG- down to 0V, turning
the opto-coupler ON. To trigger from a PNP (pull-up) photo-detector or PLC output,
connect pin 2 (TRG+) to the output of the detector and connect pin 3 (TRG-) to OV. When
the output turns ON, it pulls TRG+ up to 24V, turning the opto-coupler ON.

+3.3V

TRIG+ O—— WV |

47K : |

& T A M |

N : :

TRIG- O—— W\ i S |
47K

28V Max. Across input pins - Transition approx. 12V (Min).
Figure 8-1: In-Sight 1721/1722 Acquisition Trigger Input Schematic
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In-Sight 1700/1701 Acquisition Trigger Input Specifications

Table 8-6: Acquisition Trigger Input Specifications

SPECIFICATION DESCRIPTION

VOLTAGE ON 20 to 30V (24V nominal)
OFF 0 to 3V (12V nominal threshold)

CURRENT ON 0.9 to 1.3mA
OFF <150pA
Resistance ~22,000 Ohms
For higher current add external resistor (for example, 2.2kQ, 0.5W for 12mA) across inputs.

DELAY In-Sight 1700/ | 250 pSec latency between leading edge of trigger and start of acquisition. Input pulse
In-Sight 1701 should be minimum of 1ms wide.

The acquisition trigger input is opto-isolated. To trigger from an NPN (pull-down) type
photo-detector or PLC output, connect pin 2 (TRG+) to +24V and connect pin 3 (TRG-) to
the output of the detector. When the output turns ON, it pulls TRG- down to 0V, turning
the opto-coupler ON. To trigger from a PNP (pull-up) photo-detector or PLC output,
connect pin 2 (TRG+) to the output of the detector and connect pin 3 (TRG-) to 0V. When
the output turns ON, it pulls TRG+ up to 24V, turning the opto-coupler ON.

+3.3V

TRIG + O AN :

10K :

] :

x 1

'\. 1

< H

TRIG - O 5
10K

28V MAXIMUMACROSS INPUT PINS — TRANSITION APPROXIMATELY 12V (MIN).

Figure 8-2: In-Sight 1700/1701 Acquisition Trigger Input Schematic
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8.2.3 In-Sight 1721/1722 Status LEDs

As shown in Figure 8-3, the wafer reader provides four status LEDs; two LEDs are user-
configurable outputs. The function of each LED is listed in Table 8-7.

— - T

RJ-45 Network RJ-45 Breakout
Port Port with Notch
(Keyed)
Figure 8-3: LED Outputs
Table 8-7: LED Function
LED NUMBER LED COLOR LED FUNCTION DESCRIPTION
1 Green Network Traffic/ Flashes when receiving data and when connected to the
Network Status network.
2 Green User-Configurable | User-configurable using Discrete Output Line 4.
Red User-Configurable | User-configurable using Discrete Output Line 5.
4 Green Power On when power is connected.
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The WriteDiscrete function (Input/Output > Discrete) can be inserted in the spreadsheet
job to control the state of the two user-configurable LEDs based on an event. The output
Type can be specified in the Discrete Output dialog in the In-Sight PC Host (Figure 8-4).

>Prograred | [ Detaio |
[P Progarred | [ Detabs |
>Progarred | [ Detais |
[P Prograrred | [ Detais |
DHgh ] [ Detas |
D ] [ Detas |
PProgarred | [ Detais |
[P Progarred | [ Detabs |
PProgarred | [ Detais |
[P Progarred | [ Detabs |
PProgarred | [ Detais |
[ Prograrrred | [ Detabs |

| Careel ]

!

Figure 8-4: PC Host Default Discrete Output Dialog
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8.2.4 In-Sight 1700/1701 Status LEDs

As shown in Figure 8-5, the In-Sight 1700/1701 wafer reader provides six status LEDs;
two LEDs are user-configurable outputs. The function of each LED is listed in Table 8-8.

RJ-45 Breakout
Port with Notch
(Keyed)

RJ-45 Network
Port

Figure 8-5: LED Outputs

Table 8-8: LED Function

LED NUMBER LED COLOR LED FUNCTION DESCRIPTION
1 Red Network Traffic Flashes when receiving data.
2 Red Network Status On when connected to the network.
3 Red Network Speed On for 100Mbs network connection; off for 10Mbs.
4 Green User-Configurable | User-configurable using Discrete Output Line 4.
5 Red User-Configurable | User-configurable using Discrete Output Line 5.
6 Red Power On when power is connected.
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The WriteDiscrete function (Input/Output > Discrete) can be inserted in the spreadsheet
job to control the state of the two user-configurable LEDs based on an event. The output
Type can be specified in the Discrete Output dialog in the In-Sight PC Host (Figure 8-6).

>Prograred | [ Detaio |
[P Progarred | [ Detabs |
>Progarred | [ Detais |
[P Prograrred | [ Detais |
DHgh ] [ Detas |
D ] [ Detas |
PProgarred | [ Detais |
[P Progarred | [ Detabs |
PProgarred | [ Detais |
[P Progarred | [ Detabs |
PProgarred | [ Detais |
[ Prograrrred | [ Detabs |

| Careel ]

!

Figure 8-6: PC Host Default Discrete Output Dialog
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8.3 CAT5 Network Cable Specifications

Cognex-supplied, straight-pinned and crossover network patch cables meet
CAT5/CAT5e specifications using 568-B standard wire pairing.

Table 8-9: CAT5/CAT5e Network Cable Wiring

STRAIGHT-PINNED CROSSOVER
Signal Name RJ-45 Connectors WIRE COLOR Connector P1 Connector P2

TPO+ 1 White/Orange 1 3

TPO- 2 Orange 2 6

TPI+ 3 White/Green 3 1
TRMA 4 Blue 4 5
TRMB 5 White/Blue 5 4

TPI- 6 Green 6 2
TRMC 7 White/Brown 7 8
TRMD 8 Brown 8 7

Table 8-10: CAT5/CAT5e Network Cable 568-B Wire Pairs

PAIR # WIRE PAIRS
1 4—5
2 1-2
3 3—6
4 7—8
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8.4 Mechanical Specifications

The following sections present dimensional drawings for the In-Sight wafer readers.

NOTE All dimensions are shown in millimeters (inches).

114 COGNEX



In-Sight® 1700 Series Wafer Reader

Section 8: Specifications

8.4.1 In-Sight 1721/1722 Wafer Reader Dimensions
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Figure 8-7: In-Sight 1721/1722 Wafer Reader Dimensions
CAUTION  The wafer reader must be mounted from only one side. Mounting the wafer reader from both

sides may damage optical components. The maximum torque is 1.5 N-m (13.5 in-Ib).
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Figure 8-8: In-Sight 1721/1722 Wafer Reader Dimensions with Horizontal Mirror Mount
(Recommended Configuration)

CAUTION

The wafer reader must be mounted from only one side. Mounting the wafer reader from both
sides may damage optical components. The maximum torque is 1.5 N-m (13.5 in-Ib).
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8.4.2 In-Sight 1701 Wafer Reader Dimensions
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Figure 8-9: 1701 Wafer Reader Dimensions

CAUTION  The wafer reader must be mounted from only one side, using Positions L1 and L2 or Positions
R1 and R2, as shown in Figure 8-9. Mounting the wafer reader from both sides may damage
optical components. The maximum torque is 1.5 N-m (13.5 in-Ib).
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In-Sight® 1700 Series Wafer Reader
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Figure 8-10: 1701 Wafer Reader Dimensions with Horizontal Mirror Mount

CAUTION

The wafer reader must be mounted from only one side, using Positions L1 and L2 or Positions
R1 and R2, as shown in Figure 8-10. Mounting the wafer reader from both sides may damage
optical components. The maximum torque is 1.5 N-m (13.5 in-Ib).
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8.4.3 In-Sight 1700 Wafer Reader Dimensions
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Figure 8-11: In-Sight 1700 Wafer Reader Dimensions

CAUTION

The wafer reader must be mounted from only one side, using Positions L1 and L2 or Positions
R1 and R2, as shown in Figure 8-11. Mounting the wafer reader from both sides may damage
optical components. The maximum torque is 1.5 N-m (13.5 in-Ib).
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Appendix A

Updating the Wafer Reader’s Firmware

Install the In-Sight PC Host program, update the wafer reader’s firmware, and then
manually install the .JAR, .HTM, WaflD00.JOB, and .SET files in flash memory.

After installing and running the In-Sight PC Host, as described in Section 2.3, follow
these steps to update the wafer reader’s firmware.

NOTE This update process will erase all jobs. Make sure that all jobs are backed up on the network prior

to starting the firmware upgrade.

7
8

Open the System menu and select Logon.

In the Logon dialog, browse through the list of In-Sight Host Names on the network
and select the name of the wafer reader to upgrade. Click OK to logon to the
selected wafer reader.

While logged on to the wafer reader, open the System menu and select Save &
Load.

In the Save & Load dialog, open the drop-down list of file types in the upper-left
corner and select Firmware.

Click on <Network> to browse through the list of In-Sight Host Names on the
network. Select the Host Name of the PC running the In-Sight PC Host program.

Select the .UPD filename.
Click the Load < button to begin the firmware update process.

A Warning dialog will appear. Verify the versions of firmware, then click Yes.

After the update process is complete, the wafer reader will restart and the PC Host
program will automatically log back on.

1

Open the System menu and select Version to confirm that the wafer reader now has
the correct firmware version installed.

Open the System menu again and select Settings » .

From the Settings menu, select Network. Record the IP Address (you will need this
to complete the steps in the following sections).

Close the In-Sight PC Host program and proceed to the next section (Install Files to
the Wafer Reader Flash Memory).
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Install Files to the Wafer Reader Flash Memory

After the wafer reader’s firmware has been updated, the .HTM, .JAR, WafID00.JOB and
.SET files included in the installation package must be copied to the wafer reader’s flash
memory before it can be accessed using a web browser. The required files can be copied
into flash using a web browser or a command prompt. The files are copied to the sensor
using an FTP session from a remote host on your network.

NOTE A WAFIDOOBC.job file is also included in the installation package. This job file is identical to the
default WAFID00.JOB, except the default mark type is BC 412.

To Copy Required Files Using Microsoft Internet Explorer:

NOTE

New wafer readers are shipped with a User List containing three standard accounts: admin,

monitor and operator; each of these accounts is configured with a blank password.

1 Open the web browser.

2 Type ftp://, followed by the wafer reader’s IP address or Host Name, into the web
browser's Address bar (for example, ftp://192.68.0.1 or ftp://is1721_00060b). A Login
As dialog appears (Figure A-1).

i

Login As

Could not login to the FTP server with the user name and
pazzword specified.

FTP Server: 19216801
User Mame: Iadmin j
Paszword: I

After you login, pou can return to this FTR server easily by
adding it to pour Favorites List.

[~ Login Anonymously v Save Pazsword

o

Cancel

Figure A-1: FTP Login Dialog

3 Enter the In-Sight User Name. For example, the default In-Sight User Name is admin.

4 Enter the In-Sight Password. If the wafer reader has not been assigned a new User
Name and Password, leave the Password field empty.
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5 Click Login to log on to the In-Sight sensor's FTP file system. If the logon is
successful, all of the files currently installed on the wafer reader are displayed in the
Internet Explorer window, as shown in Figure A-2.

J File Edt Yiew Go Favoites Help

r! ftp: //admin@192.168.0.1 7 - Microsoft Internet Explorer

(=] B3

N =T 4 ”
Back Famyand Up Map Drive  Disconnect Cut
| address | TRIPERTICTERRISENNE, | 6o ||Liks »

LI G

hosts.net image.brp image.jpg proc.set

Figure A-2: Installed Wafer Reader Files

6 Open a separate Microsoft Windows Explorer window and locate the .HTM, .JAR,
WaflD00.JOB, and .SET files in the In-Sight PC Host installation directory. The
default directory is: “C:\Program Files\Cognex\In-Sight\In-Sight Wafer ID (Java)

3.x.x".

Copy and paste (or drag-and-drop) the files located in the In-Sight PC Host

installation directory to the wafer reader’s FTP file system, refresh the view; the
selected files have been copied to wafer reader flash memory and now appear in the

browser window, as shown in Figure A-3.

J File Edit “iew Go Favortes Help

tl_l ftp://admint@192.168.0.1/ - Microsoft Internet Explorer

d=' ; * ) @ E x % >
Back FtEm Up Map Drive  Dizconnect Cut
| Addess | [REERTNCIEPRIEIRE =] @60 ||Links >

A & & e

hiosts.net image. brmp image.jpg Indes html
Syztem,. html Syztem.jar ‘wiallD00jar  wWallDO00job

proc. set

Figure A-3: Installed Wafer Reader Files
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To FTP Files from a Command Prompt (in Windows):
1 Open a command prompt.

2 From the root directory, change the directory to the In-Sight PC Host installation
directory (for example, C: \Program Files\Cognex\In-Sight\In-Sight
Wafer ID (Java) 3.x.X.)

3 Open an FTP session and login to the target wafer reader by typing ftp followed by
the wafer reader’s IP address or Host Name (for example, ftp 192.168.0.1 or
is1721 00060b) as shown in Figure A-4.

NOTE To connect to a wafer reader using FTP from a non-Windows host, first copy the required files
from the C:\Program Files\Cognex\In-Sight\In-Sight\Wafer ID (Java) 3.x.x directory on the PC
to the FTP server, then open the FTP session.

AWINDOWS\system32\cmd.exe - fip is1721_00060b

Microzoft Windows HP [Uersion 5.1.260801
(G Copyright 19852001 Microsoft Corp.

F:v>c:

C:~»cd Program Files“Cognex“In—-Sight\In-Sight Wafer ID <{(Java> 3.2.5

C:~Program Filez“Cognex*In—-Sight~In—-Sight Wafer ID (Java> 3.2.5>ftp i=1721_0606AL
Connected to i=1721_HAAA6Abh.pc._.cognex.com.

228 In—Sight (R> 1721 Release 3.208.085 (624> ready (i=1721_ABB6GAL> .
User Cisl?721_BABB6ADL.pc.cognex.com:(none??: admin

238 User admin logged in.

ftp> mput *_HTH

mput Index._html? vy

2@ PORT command successful.

158 Opening Direct data connection for 18.26.808.18.

226 Data Transfer complete.

ftp: 415% bytes sent in @.80Seconds 415000 .080Kbytes sec.
mput System.html? u

2@ PORT command successful.

158 Opening Direct data connection for 10.26_HH.18.

226 Data Transfer complete.

ftp: 437 bytes sent in B.80Seconds 437008.00Kbytes/sec.
ftp> mput *_jar

mput System.jar? vy

2@ PORT command successful.

158 Opening Direct data connection for 10.26_HH.18.

226 Data Transfer complete.

ftp: 162792 bytes sent in B.28%econds 579.33Kbuytes/sec.
mput WafIDBB. jar? u

2@ PORT command successful.

158 Opening Direct data connection for 10.26_80.18.

226 Data Transfer complete.

ftp: 223935 bytes sent in B.478econds 477.47Kbytes sec.
ftp> mput WafIDBA. joh

Figure A-4: FTP Command Prompt in Windows
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4 When prompted for User:, enter the In-Sight User Name. For example, the default
In-Sight User Name is admin.

5 If prompted, enter the In-Sight Password.

6 When logged in, copy the .HTM, .JAR, WaflD00.JOB, and .SET files from their
location on the FTP server to the wafer reader by typing mput followed by the name
of the file (for example, mput *.jar copies the two .JAR files).

7 After all files have been copied, close the FTP prompt.

Once the files have been copied to the wafer reader’s flash memory, load the default job
into the spreadsheet using the PC Host’'s Save & Load dialog.
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Appendix B

Configuring Microsoft Windows Network Settings

This section provides information on how to configure Microsoft Windows network
settings to connect to a wafer reader using the In-Sight PC Host program. The steps
listed below and the example dialogs are specific to Windows NT 4.0. The exact steps
required may vary slightly in Windows XP, 2000, ME, and 98SE.

To configure Windows network settings:

1
2

Verify the PC has a TCP/IP protocol installed.
Close all programs on the PC except Windows NT.

Click Start, click Settings, and then click on the Control Panel shortcut to open the
Control Panel icon group.

Click the Network icon to open the Network dialog.

Select the Protocols tab (Figure B-1). If TCP/IP Protocol appears in this list, skip
steps 6 and 7.

MNetwork I
Identificationl Services  Protocols IAdaptersI Bindingsl

Metwork Protocols:

Add... Bemove Froperties. .. Update
— Description:
Transport Control Protocol/Internet Protocol. The default wide
area hetwark protocal that provides communication across
diverse interconnected networks.

Ok, I Cancel

Figure B-1: Windows Network Dialog, Protocols Tab

COGNEX 127



Configuring Microsoft Windows Network Settings In-Sight® 1700 Series Wafer Reader

6 If TCP/IP is not on the list of installed protocols, click Add to open the Select Network
Protocol dialog (Figure B-2).

Select Metwork Protocol EB

Click the Metwork Protocol that you want to install, then click OF. If
‘? you have an inztallation digk for thiz compaonent, click Have Disk.

Metwork Protocol:

W~ NetBELI Protocal |
T M Link IP=/5 P Compatible Transport

T Pairt To Paint Tunneling Pratocal

U Streams Erviranment

W TCPAR Pratocol

-

Have Disk. .. |

(] I Cancel |

Figure B-2: Select Network Protocol dialog

7 Select TCP/IP Protocol and click OK. Windows NT will install the protocol and return
to the Network dialog.

8 Configure the IP Address and Subnet Mask.

9 Highlight TCP/IP Protocol in the Protocols tab and click Properties to open the
Microsoft TCP/IP Properties dialog (Figure B-3):

Microsoft TCP/IP Properties HE
IP Adhess | DNS | WINS Address | Routing|

An IP address can be automatically azzigned to this network, card
by a DHCP zerver. |f your network does not have a DHCP server,
azk your network. administrator for an address, and then tppe it in
the space below.

Adapter:
I[‘I] SMC EZ Card 104100 PCI (SMC1211 Series) j

" Obtain an IP address from a DHCP server
& Specify an P address

1P Address: 192 168, 0 . 2

Subnet Mask: I 285255256, 00
Default Gateway: I . . .

Advanced... |

Cancel | Apply |

Figure B-3: Microsoft TCP/IP Properties Dialog
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10 Click the Specify an IP address radio button. The IP Address and Subnet Mask fields,
which are grayed-out when DHCP is enabled, become active.

11 Enter an appropriate Subnet Mask. The Subnet Mask defines which part of the wafer
reader’s IP address refers to the network and which part refers to the host. The
network part of the IP address is the same for all hosts on the same subnet, and the
remainder is unique to each host. The default Subnet Mask setting of 255.255.255.0
is usually appropriate.

12 Click OK twice, then restart Windows if prompted to do so.
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Appendix C

Connecting the Breakout Module

The optional In-Sight Breakout Module (P/N 800-5743) is more convenient than using the
standard Breakout Cable to connect the wafer reader’s power, serial communications,
and /O lines.

For additional information on connecting a Breakout Module, see Section 8.2.1: Breakout
Port Pin Assignments on page 106 or the Breakout Module Installation and Reference
manual (P/N 597-0008-xx).

To serial device

To In-Sight
Power Adapter
To In-Sight system 4

9-pin DSUB
/ connector
; Trigger (input), discrete

15-pin DSUB | | & outputs, 24VDC
onnedior 54— (16-pin terminal block)

2-pin Power
Adapter plug

Figure C-1: Breakout Module Connections
To Connect the Breakout Module to the In-Sight Wafer Reader:

1 Verify the 24VDC power supply being used is switched off.

2 Optionally, connect the power and ground wires for the acquisition trigger input and
the discrete outputs into their corresponding terminals on the Breakout Module.

3 Optionally, connect the 9-pin male DSUB connector of an RS-232 serial cable into
the corresponding 9-pin female connector on the Breakout Module.

4 Plug the Breakout Cable’s 15-pin male DSUB connector into the corresponding
female connector on the Breakout Module.

5 Plug the RJ-45 connector of the Breakout Cable into the wafer reader’s Breakout
Port. The cable’s connectors are “keyed” to the notch in the Breakout Port.

6 Plug the wire leads from a 24VDC supply for the +24V power and ground into the
2-pin terminal plug on the Breakout Module. Alternatively, remove the terminal plug
and insert the 2-pin terminal plug attached to the In-Sight power adapter into the
keyed power adapter port on the Breakout Module (Figure C-1).
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7 Restore power to the 24V supply. The green power LED on the wafer reader and the
orange +24V LED on the Breakout Module will indicate that the wafer reader and
Breakout Module are receiving power.
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1721/1722 Wafer Reader Installation Options

Horizontal Mirror Attachment

The optional horizontal mirror attachment (P/N 800-5796) allows the wafer reader to be
installed in top or bottom-side reading applications where a low mounting profile is
required.

To attach the mirror mount:
1 Align holes of the mirror attachment to holes on the front plate of the wafer reader.

2 Insert the two M3 X 14mm hex head screws (provided) through the mirror mount, into
the front plate.

3 Tighten screws with a 2.5mm Allen wrench.

Figure D-2: Optional Mirror Mounting Configuration
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1721/1722 Wafer Reader Installation Options

In-Sight® 1700 Series Wafer Reader

The working distance is adjustable, with a factory-set option of 50.0mm when vertically mounted.
The useable working distance range is 1 to 80.0mm for the wafer reader in the vertical position.

NOTE The Image Orientation may need to be adjusted, depending on the configuration of the wafer
reader and the mirror attachment installation.

WAFER
]
OPTICAL ?
<56.0mm PATH
WORKING <54.9mm
DISTANCE WORKING
10 MIRROR DISTANCE
<67.9mm VOUNT I TO HOUSING
FACE
MIRROR
121mm  ——===

RECOMMENDED MIRROR MOUNTING
CONFIGURATION
FOR HORIZONTAL WAFER READER MOUNTING

13.0mm
<80.0mm

WORKING DISTANCE
FROM CAMERA FACE

—— r~-— 12,1 mm
MIRROR
130mm % OPTICAL
o * PATH
(=] 23.8mm
<56.0mm * *
WORKING |
<67.9mMm - piSTANCE <441mm
OPTICAL TO MIRROR WORKING
PATH MOUNT DISTANCE
FACE OPTICAL TO HOUSING
PATH
]
WAFER
OPTIONAL MIRROR MOUNTING
CONFIGURATION
FOR HORIZONTAL WAFER READER MOUNTING
(]
s O
lt————— 238mm
[
VERTICAL WAFER READER
MOUNTING
|
OPTICAL
PATH
]
WAFER

Figure D-3: Working Distances in Horizontal and Vertical Mounting Configurations

configurations.

NOTE The wafer reader can be mounted face-up or face-down in both horizontal mirror mounting
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Table D-1 shows examples of the wafer reader’s vertical working distances and the
corresponding horizontal working distances required at the same focal setting.

Table D-1: Working Distances

Corresponding Horizontal Working Distance
Vertical Working Recommended Mirror Mounting Optional Mirror Mounting
Distance
To Mirror Mount To Housing To Mirror Mount To Housing
Face Face

5.0mm N/A N/A N/A N/A

10.0mm N/A N/A N/A N/A

15.0mm N/A N/A N/A N/A

20.0mm N/A N/A N/A N/A

25.0mm 1.0mm N/A 1mm N/A

30.0mm 6.0mm 4.9mm 6.0mm N/A
40.0mm 16.0mm 14.9mm 16.0mm 4.1mm
50.0mm" 26.0mm 24.9mm 26.0mm 14.1mm
60.0mm 36.0mm 34.9mm 36.0mm 24.1mm
70.0mm 46.0mm 44 9mm 46.0mm 34.1mm
80.0mm 56.0mm 54.9mm 56.0mm 44 1mm

* Indicates factory-set working distances

Adjusting the Focus on the 1721/1722

The recommended working distance range is 1 to 80.0mm for the wafer reader in the
vertical position. If using the horizontal mirror mount, the recommended working distance
range is 1 to 56.0mm.

Once the working distance is established and an image is acquired, the focus can be
adjusted using the focus adjustment screw (M3 hex screw), located in the center of the
wafer reader’s front face-plate (see Figure D-4). To adjust the focus, use a 2.5mm Allen
wrench. Turn the focus adjustment screw clock-wise if the wafer reader is moved closer
to the wafer; turn the screw counter clock-wise if the wafer reader is moved farther away
from the wafer.

Figure D-4: Location of Focus Adjustment Screw
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Image Artifacts

Under certain conditions, horizontal lines may be observed in the image (Figure D-5).
These lines are artifacts of the wafer reader’s optical design. They are most visible at a
working distance of approximately 30.0mm, when the Light Mode setting is Dark Field
(for more information of Light Modes, see Section 3.5.10). In most cases, these lines will
have no impact on reading performance. If desired, position the mark in an area of the
field of view that is free of artifacts. To reduce the intensity of the lines, the lighting can be
optimized using the automated tuning process (Section 3.5.16).

Figure D-5: Image Artifact Example
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1701 Wafer Reader Installation Options

1701 Horizontal Mirror Attachment

The optional horizontal mirror attachment (P/N 800-5796) allows the wafer reader to be
installed in top or bottom-side reading applications where a low mounting profile is
required.

The horizontal mirror attachment can be mounted face-down or face-up (see Figure E-1).
To attach the mirror mount:

1 Align holes of the mirror attachment to holes on the front plate of the 1701 wafer
reader.

2 Insert the two M3 X 14mm hex head screws (provided) through the mirror mount, into
the front plate.

3 Tighten screws with a 2.5mm Allen wrench.

Figure E-1: Attaching the 1701 Horizontal Mirror Mount
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As shown in Figure E-2, the horizontal mirror attachment lengthens the optical path by
23.9mm. To compensate, the working distance of the wafer reader in the horizontal
configuration will be 23.9mm closer to the wafer than a wafer reader mounted vertically
with the same focal setting. The working distance for the vertical configuration is
measured from the bottom of the wafer reader to the top of the wafer.

NOTE The Image Orientation may need to be adjusted, depending on the configuration of the wafer
reader and the mirror attachment sating. Refer to Section 3.5.9: Image Orientation for more
information.

WAFER

s )

i
WORKING |
DISTANCE ; 12.0mm

i 11.9mm
‘OPTICAL O
I PATH

MIRROR

=== - MIRROR
{OPTICAL
| PATH 11.9mm
i
: o e S I
WORKING -
DISTANCE L 20mm
‘ WAFER ! X
i
O |
|
i
L T
[
WORKING 10PTICAL
DISTANCE PATH

i
WAFER ;

f )

Figure E-2: Working Distances in Horizontal and Vertical Mounting Configurations
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Table E-1 shows examples of the 1701 wafer reader’s vertical working distances and the
corresponding horizontal working distances required if no focal adjustment is made.

Table E-1: Working Distances

VERTICAL WORKING DISTANCE R 1R Z ONTAL
5mm N/A
10.0mm* N/A
15.0mm N/A
20.0mm N/A
25.0mm 1.1mm
30.0mm 6.1mm
40.0mm 16.1mm
50.0mm* 26.1mm
60.0mm 36.1mm
70.0mm 46.1mm
80.0mm 56.1mm

* Indicates factory-set working distances

Adjusting the Focus on the 1701

The recommended working distance range is 1 to 80.0mm for the 1701 wafer reader in
the vertical position. If using the horizontal mirror mount, the recommended working
distance range is 1 to 56.1mm.

Once the working distance is established, the focus can be adjusted using the focus
adjustment screw (M3 hex screw), located in the center of the 1701 wafer reader’s front
face-plate (see Figure E-3). To adjust the focus, use a 2.5mm Allen wrench. Turn the
focus adjustment screw clock-wise if the wafer reader is moved closer to the wafer; turn
the screw counter clock-wise if the wafer reader is moved farther away from the wafer.

Figure E-3: Location of Focus Adjustment Screw
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Image Artifacts

Under certain conditions, horizontal lines may be observed in the image (Figure E-4).
These lines are artifacts of the wafer reader’s optical design. They are most visible at a
working distance of approximately 30.0mm, when the Light Mode setting is Dark Field
(for more information of Light Modes, see Section 3.5.10). In most cases, these lines will
have no impact on reading performance. If desired, position the mark in an area of the
field of view that is free of artifacts. To reduce the intensity of the lines, the lighting can be
optimized using the automated tuning process (Section 3.5.16).

Figure E-4: Image Artifact Example
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Appendix F

In-Sight 1700 Wafer Reader Mount Conversion

The In-Sight 1700 wafer reader can be mounted either horizontally or vertically
depending on the positions of the read window and light trap (see Figure F-1). The
In-Sight 1700 wafer reader can be easily converted from one mounting configuration to
the other. In the following example, a horizontal mount In-Sight 1700 wafer reader is
converted to a vertical mount.

NOTE If possible, perform these steps within a cleanroom environment (Class 1000 or better) at an
electrostatic discharge (ESD)-safe workstation. Use cleanroom-approved gloves to avoid
fingerprints on the read window. If the conversion is not done in a cleanroom, there is a possibility
of introducing "artifacts" on the optics. Also, depending on the Class of the cleanroom where the
wafer reader will be used, the wafer reader may no longer meet Class specifications after the
conversion has been done.

To convert the mount configuration:

1 Using a .050 inch Allen wrench, remove the two 2-56 x 3/16" button head screws that
attach the light trap, and the two screws that attach the read window.

Read Window

Light Trap \‘1

L~

Figure F-1: Location of Light Trap and Read Window (Horizontal Mount Configuration)

COGNEX 141



In-Sight 1700 Wafer Reader Mount Conversion In-Sight® 1700 Series Wafer Reader

2 Remove the light trap and read window from the In-Sight 1700 wafer reader case.

Figure F-2: Removing the Light Trap and Read Window

3 Place the read window, with the top of the frame (thick edge of wedge) facing down,
in the opening that was occupied by the light trap; place the light trap, with the top
nearest to the back of the wafer reader, in the other opening.

Read Window Light Trap

Figure F-3: Read Window and Light Trap Orientation
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Figure F-4: Reattaching the Read Window and Light Trap

4 Tighten all four screws, with a maximum torque of 2 inch-Ibs.

Light Trap

Read Window \

Il

Figure F-5: Vertical Mount Configuration (Shown Horizontally)
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Appendix G

Cleaning the Reader

To maintain optimal imaging and reading performance, keep the glass read window free
of dust and fingerprints. To remove dust, use a pressurized air duster. If the window
needs cleaning, use a lens cleaning cloth or a cleaner approved for use on coated optics.
Do not spray water or cleaning fluids directly onto the glass window, which could allow
moisture to enter the case.
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